{\ AUTODESK T .
official Press Geo @’ e @mf@ j .

Brian C. Benton

/ | 1'

Mastering AutoCAD'
and AutoCAD LT

i il .
L o :
; (4 SYBEX
';/f’/b A Wiloy Brand







TODES

ized Publisher




Acquisitions Editor: Jody Lefevere

Development Editor: Gary Schwartz

Technical Editor: Richard Hawley

Production Editor: Rebecca Anderson

Copy Editor: Judy Flynn

Editorial Manager: Mary Beth Wakefield
Production Manager: Kathleen Wisor

Executive Editor: Jim Minatel

Book Designers: Maureen Forys, Happenstance Type-O-Rama; Judy Fung
Proofreader: Kim Wimpsett

Indexer: Ted Laux

Project Coordinator, Cover: Brent Savage

Cover Designer: Wiley

Cover Image: ©Wilfried Krecichwost/Getty Images

Copyright © 2017 by John Wiley & Sons, Inc., Indianapolis, Indiana
Published simultaneously in Canada

ISBN: 978-1-119-38679-7
ISBN: 978-1-119-41420-9 (ebk.)
ISBN: 978-1-119-41425-4 (ebk.)

Manufactured in the United States of America

No part of this publication may be reproduced, stored in a retrieval system or transmitted in any form or by any means, electronic, mechan-
ical, photocopying, recording, scanning or otherwise, except as permitted under Sections 107 or 108 of the 1976 United States Copyright Act,
without either the prior written permission of the Publisher, or authorization through payment of the appropriate per-copy fee to the
Copyright Clearance Center, 222 Rosewood Drive, Danvers, MA 01923, (978) 750-8400, fax (978) 646-8600. Requests to the Publisher for per-
mission should be addressed to the Permissions Department, John Wiley & Sons, Inc., 111 River Street, Hoboken, NJ 07030, (201) 748-6011,
fax (201) 748-6008, or online at http: //www.wiley.com/go/permissions.

Limit of Liability/Disclaimer of Warranty: The publisher and the author make no representations or warranties with respect to the accuracy
or completeness of the contents of this work and specifically disclaim all warranties, including without limitation warranties of fitness for a
particular purpose. No warranty may be created or extended by sales or promotional materials. The advice and strategies contained herein
may not be suitable for every situation. This work is sold with the understanding that the publisher is not engaged in rendering legal,
accounting, or other professional services. If professional assistance is required, the services of a competent professional person should be
sought. Neither the publisher nor the author shall be liable for damages arising herefrom. The fact that an organization or Web site is
referred to in this work as a citation and/or a potential source of further information does not mean that the author or the publisher
endorses the information the organization or Web site may provide or recommendations it may make. Further, readers should be aware that
Internet Web sites listed in this work may have changed or disappeared between when this work was written and when it is read.

For general information on our other products and services or to obtain technical support, please contact our Customer Care Department
within the U.S. at (877) 762-2974, outside the U.S. at (317) 572-3993 or fax (317) 572-4002.

Wiley publishes in a variety of print and electronic formats and by print-on-demand. Some material included with standard print versions
of this book may not be included in e-books or in print-on-demand. If this book refers to media such as a CD or DVD that is not included in
the version you purchased, you may download this material at http: //booksupport.wiley.com. For more information about Wiley prod-

ucts, visit www.wiley.com.

Library of Congress Control Number: 2017936607

TRADEMARKS: Wiley, the Wiley logo, and the Sybex logo are trademarks or registered trademarks of John Wiley & Sons, Inc. and /or its
affiliates, in the United States and other countries, and may not be used without written permission. AutoCAD and AutoCAD LT are regis-
tered trademarks of Autodesk, Inc. All other trademarks are the property of their respective owners. John Wiley & Sons, Inc. is not associ-
ated with any product or vendor mentioned in this book.

10987654321


http://www.wiley.com/go/permissions
http://booksupport.wiley.com
http://www.wiley.com

To my friend and colleague David Fawcett, who is
retiring soon: fair winds and following seas...



Acknowledgments

Many talented and hardworking people gave their best effort to produce Mastering AutoCAD
2018 and AutoCAD LT 2018. I offer my sincerest gratitude to those individuals who helped bring
this book to you.

Heartfelt thanks go out to the editorial and production teams at Sybex for their efforts.

Mary Beth Wakefield managed the project and helped us make all the right connections. Jody
Lefevere made sure things got off to a great start and provided support from beginning to end.
Gary Schwartz skillfully managed the development process. Richard Hawley did an excel-

lent technical editing job and offered many great suggestions. On the production side, Rebecca
Anderson kept the production end of things running smoothly, and Judy Flynn made sure that I
wasn't trying out new uses of the English language.

Thanks also go to Denis Cadu, who has always given his support to our efforts over many
projects. Jim Quanci always gives his generous and thoughtful assistance to us author types.
Thanks to Elinor Actipis for providing help with general Autodesk matters. Finally, thanks
go to Alison Keller, Daniel Kuhman, and KB Lee of the AutoCAD Customer Counsel and the
AutoCAD team for generously allowing us to have a look at the prerelease software.

And a great big thank you to my family and friends, who have been there for me through
thick and thin.



About the Authors

George Omura is a licensed architect, Autodesk Authorized Author, and CAD
specialist with more than 28 years of experience in AutoCAD and over 35
years of experience in architecture. He has worked on design projects ranging
from resort hotels to metropolitan transit systems. George has written numer-
ous other AutoCAD books for Sybex, including Mastering AutoCAD 2017 and
AutoCAD LT 2017.

Brian C. Benton is a CAD manager, CAD service provider, technical writer,
and blogger. He has over 20 years of experience in various design fields
(mechanical, structural, civil, survey, marine, environmental) and is well versed
in many design software packages (CAD, GIS, and graphics). He has been
Cadalyst magazine’s Tip Patroller, AUGI HotNews production manager, and
Infinite Skills” AutoCAD training video author.







Contents at a Glance

Introduction .. ... ... . xxX0
Part1eTheBasics .......couiiiiiiiiiiiiiii i it iiiiiiinineiennannnennn 1
Chapter 1 ® Exploring the Interface ..................... ... ... ... ......... 3
Chapter 2 e Creating Your First Drawing ................... ... ... ... ... .. .. 31
Chapter 3 e Setting Up and Using the Drafting Tools ........................... 79
Chapter 4 ¢ Organizing Objects with Blocks and Groups ....................... 119
Chapter 5 ® Keeping Track of Layersand Blocks .............................. 149
Part 2 « Mastering IntermediateSkills ..............cciiiiiiiiiiiiiennn. 181
Chapter 6 ¢ Editing and Reusing Data to Work Efficiently ...................... 183
Chapter 7 ® Mastering Viewing Tools, Hatches, and External References ......... 225
Chapter 8 e Introducing Printing, Plotting, and Layouts ....................... 273
Chapter 9 ® Adding Text to Drawings .............. ... .. ... ..o oiiia.. 305
Chapter 10 ® Using Fieldsand Tables ........................................ 341
Chapter 11 ® Using Dimensions . ............. ... ..., 363
Part 3 « Mastering Advanced Skills ................ ... ... . i il 415
Chapter 12 ® Using Attributes ......... .. ... ... ... ... . i 417
Chapter 13 ® Copying Existing Drawings from Other Sources .................. 445
Chapter 14 e Advanced Editing and Organizing .............................. 473
Chapter 15 ¢ Laying Out Your Printer Output................................. 517
Chapter 16 ¢ Making “Smart” Drawings with Parametric Tools ................. 543
Chapter 17 ® Using DynamicBlocks ............. ... ... .. ... ... ... ..., 563
Chapter 18 ® Drawing Curves . ...ttt 595

Chapter 19 e Getting and Exchanging Data from Drawings ..................... 627



VIII

CONTENTS AT A GLANCE

Part 4 « 3D ModelingandImaging ..............ciiiiiiiiiiiiiiinenennn. 659
Chapter 20 ® Creating 3D Drawings ............. ... ... . ... 661
Chapter 21 ¢ Using Advanced 3D Features ................................... 703
Chapter 22 ¢ Editing and Visualizing 3D Solids ............................... 759
Chapter 23 ¢ Exploring 3D Mesh and Surface Modeling ........................ 805
Part 5 « Customization and Integration ..............cciciiiiiiineienennn. 853
Chapter 24 ¢ Customizing Toolbars, Menus, Linetypes, and Hatch Patterns ... .. .. 855
Chapter 25 ® Managing and Sharing Your Drawings .......................... 897
Part6e Appendixes . .......coviiiiiiiiiiiiiiieieneateneienearaneeanennas 947
Appendix A e The Bottom Line ............ ... .. ... ... . . i .. 949
Appendix B ¢ Installing and Setting Up AutoCAD ............................ 973
Appendix C ¢ The Autodesk AutoCAD 2018 Certification ..................... 1003
Index ... 1007



Contents

Introduction . ... XXU
Part 1eTheBasics .....vuvtiiiiiiiiiiii ittt iniieieeneneneennannnnnns 1
Chapter 1 - ExploringtheInterface ............cciiiiieiiiiieiennn, 3
Takinga Guided Tour ....... ... .. 3
Launching AutoCAD ... ... ... . 4
The AutoCAD Window ........ ... 5
Using the Application Menu ............ ... ... .. i 8
Using theRibbon ........... . . . 9
Picking Points in the Drawing Area ................ ... ..., 14
Using the UCSIcon ........ ... 15
Working in the Command Window ........................................ 15
Working with AutoCAD ... ... .. . . 16
Opening an Existing File ......... ... ... ... ... . i 16
Gettinga Closer Look ........ ... i 18
SavingaFileasYouWork ........ ... ... .. i 21
Making Changes .......... ...t 22
Working with Multiple Files .............. ... ... .. .. ... .. ... 23
Adding a Predrawn Symbol with the Tool Palettes ........................... 26
TheBottom Line .............. . 28
Chapter 2 » Creating Your FirstDrawing . ................coivinnn.. 31
Getting to Know the Home Tab’s Draw and Modify Panels ...................... 31
Starting Your First Drawing ................ .. ... 34
Specifying Exact Distances with Coordinates .................................. 38
Specifying Polar Coordinates ................ ... ... i 40
Specifying Relative Cartesian Coordinates .................................. 41
Interpreting the Cursor Modes and Understanding Prompts ..................... 43
Understanding Cursor Modes ............. ... . ... ... ... ... .. 43
Choosing Command Options ............... ... i ... 45
Selecting Objects ........... .. i 50
Selecting Objects in AutoCAD . ......... ... ... i 50
Providing Base Points ......... ... ... ... . 53
Using Noun/Verb Selection ............. ... ... . i .. 56
Editing with Grips ....... .. 61
Stretching Lines by Using Grips ............ ... ... . it 62
Moving and Rotating with Grips ................... ... ... ... ... ... 64
Understanding DynamicInput ............. ... ... ... ... i 66
Displaying Dataina Text Window ............. ... ... ... ... ... ... ....... 71

Displaying the Properties of an Object ................. ... ... .. ... ... ..., 72



X

CONTENTS

Getting Help ... 75
Using theInfoCenter ........ ... .. ... .. i 75
Finding Additional Sourcesof Help ............... .. ... ... ... ... ..., 76

The Bottom Line ........... ... 77

Chapter 3 » Setting Up and Using the DraftingTools ................. 79

Setting UpaWork Area ......... ... 79
Specifying Units .. ... 80
Fine-Tuning the Measurement System . ............... ... ... ..o, 82
Setting Up the Drawing Limits ............. ... ... .. .. oo i, 83
Looking at an Alternative to Limits ............. ... ... ... ... ... oL 85
Understanding Scale Factors ............... ... ... .. ... i 85
Using Polar Tracking .......... ... ... .. i 87
Setting the Polar Tracking Angle ........... ... ... ... ... ... .. ... ......... 88

Exploring the Drawing Process ............. ... ... ... .. 90
Locating an Object in Reference to Others .................................. 90
Gettinga Closer Look . ...... ... 91
Modifyingan Object .......... ... i 91

Planning and Laying Outa Drawing ................... ... ... . ... ..., 95
Making a Preliminary Sketch .............. ... .. .. ... i 97
Using the Layout ........... ... .. .. . i i 98
Erasing the Layout Lines ............... ... ... ... . . i, 103
Putting on the Finishing Touches ............. ... ... . ... ... ... ... ... 106
Aligning Objects by Using Object Snap Tracking ........................... 107

Using the AutoCAD Modes as Drafting Tools ................................. 113
Using Grid Mode as a Background Grid ......................... ... ... ... 113
UsingSnap Modes ... 116

The Bottom Line ..... ... ... 117

Chapter 4 » Organizing Objects with Blocks and Groups ............. 119

Creatingand UsingaSymbol .......... ... .. .. ... ... ... . i 119
Understanding the Block Definition Dialog Box ............................ 121
Insertinga Symbol ............ . 123
Scaling and Rotating Blocks . ............. .. ... ... ... L 126
Using an Existing DrawingasaSymbol ................................... 128

Modifying aBlock . ... 130
Unblocking and RedefiningaBlock .............. ... ... ... ... ... 130
Saving a Blockasa Drawing File ............. ... ... .. ... ... ... ... 132
Replacing Existing Files with Blocks .................. ... ... . ... ... ... 133
Understanding the Write Block Dialog Box Options ......................... 134
Other Uses for Blocks ........ ... .. . i 134

Understanding the AnnotationScale .................... ... ... ... ... ... 135

Grouping Objects .......... .. 138
Modifying Membersof aGroup ................iiiiiiiiiiii 140
Ungrouping, Adding, and Subtracting fromaGroup ........................ 143
Working with the Object Grouping Dialog Box ............................. 144
Working with the AutoCAD LT Group Manager ............................ 146

The Bottom Line . ... . 147



CONTENTS | XI

Chapter 5 ¢« Keeping Track of Layersand Blocks ..................... 149
Organizing Information with Layers . .................... ... ... ... ...... 149
Creating and Assigning Layers ............... ... ... .. i, 150
WorkingonLayers.......... ... i 158
Controlling Layer Visibility ........... ... ... ... 161
Finding the Layers YouWant . ........... ... ... i i i 163
Taming an Unwieldy Listof Layers ........... ... .. ... ... ... .. ..., 164
Assigning LinetypestoLayers .................... ... ... ... oL 171
Adding a LinetypetoaDrawing ............. ... ... .. . i, 172
Controlling Lineweights . . ......... ... ... .. ... ... . 177
Keeping Track of Blocksand Layers ..................... ... ... 177
Getting a Text File List of Layersor Blocks ................. ... ... ........ 178
TheBottom Line ........... . 179
Part 2 « Mastering IntermediateSkills ..............coiiiiiiiiiiiiiinen, 181
Chapter 6 - Editing and Reusing Data to Work Efficiently ............ 183
Creating and Using Templates .............. .. ... ... . ... .. 184
CreatingaTemplate . ................ 184
UsingaTemplate ............... i 185
Copying an Object Multiple Times .............. ... ... . .. ... .. 186
Making Circular Copies .............. i 186
Making Row and Column Copies ..., 188
Fine-Tuning Your View ........ ... ... ... i 190
Finishing the Kitchenette .............. .. ... ... ... ... . ... ... ... ... 192
Array AlongaPath ....... ... ... .. 193
Making Changes to an Associative Array .................ooiiuiiaiinn... 194
Developing Your Drawing .............. . o i i 198
Importing Settings .. ... .. . 198
Using Osnap Tracking to Place Objects .................. ... ... ... .. ...... 201
Finding an Exact Distance AlongaCurve ................. ... ..., 218
Changing the Length of Objects . ............ .. ... ... . ... .. .. 220
Creating a New Drawing by Using Parts
from Another Drawing ........ ... ... i 221
Eliminating Unused Blocks, Layers, Linetypes, Shapes, Styles, and More ... ... 222
TheBottom Line ......... .. .. . 224

Chapter 7 « Mastering Viewing Tools, Hatches, and

ExternalReferences ........... ... ciiitiiiiiiiiiiiiiiiiiennennnn. 225
Assembling the Parts ............ ... . . .. 225
Taking Control of the AutoCAD Display .............. ... ..., 229
Understanding Regeneration and Redrawing ..................... ... ... ... 229
Saving VIEWS ... 230
Understanding the Frozen Layer Option ................. ... ... .. ... ...... 233
Using Hatch Patterns in Your Drawings .................. ... ... . ..., 235
Placing a Hatch Pattern in a Specific Area................ ... ... .. ... ...... 235

Adding Predefined Hatch Patterns . ............. ... ... .. ... ... ... ... 237



XII

CONTENTS

Positioning Hatch Patterns Accurately .................. ... ... ... ...... 239
Updating a Block from an External File . ............... ... ... .. ... ... ... 240
Changingthe Hatch Area........... ... ... ... ... . .. o .. 242
Modifying a Hatch Pattern.................. ... ... ... ... ..., 243
Understanding the Boundary Hatch Options .............................. ... 245
Controlling Boundaries with the Boundaries Panel ......................... 245
Fine-Tuning the Boundary Behavior ................................... ... 245
Controlling Hatch Behavior with the Options Panel ......................... 246
Controlling Hatch Default Layer, Layout Scale, and ISO Line Weight .......... 247
Using Additional Hatch Features ..................... ... ............... 248
Using GradientShading ............ ... ... . ... . 249
Tipsfor Using Hatch .......... ... ... .. .. ... 250
Space Planning and Hatch Patterns ................... ... ... .. ... ... ... 251
Using External References .......... ... ... .. . i 254
Attaching a Drawing as an External Reference ............................. 255
Other Differences Between External References and Blocks .................. 259
Other External Reference Options ............ ... ... . ... ... .. 260
Clipping Xref Views and Improving Performance .......................... 262
Editing XrefsinPlace ............ . 265
Using the External Reference Tab ..................... ... ... . ... ... ... 268
Adding and Removing Objects from Blocks and Xrefs ....................... 268
Understanding the Reference Edit Dialog Box Options ...................... 270
TheBottom Line ...... ... .. 272
Chapter 8 « Introducing Printing, Plotting, and Layouts ............. 273
Plotting the Plan ............ ... 273
Understanding the Plotter Settings .............. ... ... . ... ... ... ... ... 277
PaperSize ...... ... .. 278
Drawing Orientation ............... .. ... ... 278
Plot Area . ... 278
PlotScale ...... ..o 280
Shaded Viewport Options ............... . i 283
Plot Offset .. ... 284
Plot Options . ... 285
Exit Options . ... ... 286
Plotting Using Layout Views . ....... ... .. ... i 286
Setting Plot Scale in the Layout Viewports ................................. 289
Adding an Output Device .......... .. ... i 291
Editing a Plotter Configuration .............. ... ... ... ... . ... ...... 293
StoringaPageSetup ............ o 295
Using Electronic Plots . . ......... 299
Exporting to PDF Through the Plot Dialog Box ............................. 299
Exporting to PDF Through the Export To DWF/PDF Ribbon Panel ............ 301
Exporting Autodesk DWF and DWEx Files . ...................... ... ... ... 302

The Bottom Line . ... . 302



CONTENTS
Chapter 9 « Adding TexttoDrawings ...........c.coviieieienennnnn. 305
Preparing a Drawing for Text .............. ... . i i i 305
Organizing Textby Styles........ ... ... ... . .. 306
Getting Familiar with the Text and Annotation Scale Control Panels .......... 308
Setting the Annotation Scale and Adding Text ................................ 308
Inserting Text ...... .. o 309
Exploring Textand Scale ............. ... . i 310
Understanding the Text Style Dialog Box Options ............................. 313
StYles 313
Set Current/New/Delete .. .......... e 313
Font . .. 313
Iz 314
Effects ... 314
Exploring Text Formatting in AutoCAD .......... ... ... ... ... ... .. ... 315
Adjusting the Text Heightand Font ........... ... ... . ... ... ... ... ... 315
Understanding the Text Editor Tab .. .......... ... ... ... . ... ... ..., 317
Adding Symbols and Special Characters ................................... 319
Setting Indentsand Tabs ................ .. ... . 321
What Do the Fonts Look Like? .............. ... ... ... . . .. 324
Adding Simple Single-Line Text Objects ................... ... ... ... ...... 326
Justifying Single-Line Text Objects . ........... ... ... .. . ..o, 328
Using Special Characters with Single-Line Text Objects . ..................... 330
Using the Check Spelling Feature ............... ... ... ... ... ... ... ..., 331
How Check Spelling Works .............. .. .. o i i i 331
Choosing a Dictionary ............ ... .o i 332
Substituting Fonts .......... ... .. 334
Finding and Replacing Text . ........ ... ... .. .. i 335
TheBottom Line ............ ... . 339
Chapter 10 « Using Fieldsand Tables ........................c0utt. 341
Using Fields to Associate Text with Drawing Properties ........................ 341
Adding Tables to Your Drawing ............. .. ... i 345
CreatingaTable .......... .. .. . 345
Adding Cell Text ... 346
Adjusting Table Text Orientation and Location ............................. 348
Editing the Table Line Work ........ ... .. ... .. ... ... . . i, 351
Adding FormulastoCells .......... .. ... 354
Using Formulas DirectlyinCells ............. ... ... ... ... ... ..., 354
Using Other Math Operations ................ ... ... . . .. 355
Importing and Exporting Tables .................. ... ... ... ... ... ..., 356
ImportingaTable . ........... . 356
Exporting Tables ......... ... ... . . 358
Creating Table Styles ........ ... ... . i 359
Adding or ModifyingaTableStyle.................... ... ... ... L 359
The Table Style Options ............ ... . i, 361

The Bottom Line . ... . 361

XIII



XIV

CONTENTS

Chapter 11+ UsingDimensions ............coitiiiiiieienenennnnn. 363
Understanding the Components of a Dimension .............................. 363
Creatinga Dimension Style ......... ... ... ... . ... .. 364
Setting Up the Primary UnitStyle ............ ... ... .. ... ... ... ... ... 367
Setting the Height for Dimension Text . ............. ... ... ... ... ....... 368
Setting the Location and Orientation of Dimension Text ..................... 369
Choosing an Arrow Style and Setting the Dimension Scale .................. 370
Setting Up Alternate Units ............... .. ... i i i 374
Setting the Current Dimension Style .................... ... ... .. ... ...... 375
Modifying a Dimension Style ............... ... ... .. .. i 375
Drawing Linear Dimensions ................... ... ... ... ... ... ... ... ..., 376
Understanding the Dimensions Panel ..................................... 376
Placing Horizontal and Vertical Dimensions ............................... 377
Continuing a Dimension ................ ... .. . i i 378
Drawing Dimensions from a Common Base Extension Line .................. 380
Adjusting the Distance Between Dimensions ............................... 382
Editing DImensions ............ ... i 383
Appending Data to Dimension Text ................... ... ... ... ... 383
Using Grips to Make Minor Adjustments to Dimensions ..................... 385
Changing Style Settings of Individual Dimensions . ......................... 387
Editing Dimensions and Other Objects Together............................ 388
Associating Dimensions with Objects .............. ... ... ... . ... ... ... 391
Adding a String of Dimensions with a Single Operation ..................... 392
Adding or Removing the Alternate Dimensions ............................ 393
Dimensioning Nonorthogonal Objects ....................................... 394
Dimensioning Nonorthogonal Linear Distances ............................ 394
Dimensioning Radii, Diameters,and Arcs ................................. 396
Skewing Dimension Lines .............. ... ... i 400
Using the Dimension Tool .......... ... ... .. .. i i 401
Adding a Note with a Leader Arrow .......... ... ... .. ... .. 404
Creating Multileader Styles ............. ... ... ... .. i 406
Editing Multileader Notes .............. ... ... i i i 409
Breaking a Dimension Line foraLeader ................................... 409
Applying Ordinate Dimensions .............. ... ... oo in... 410
Adding Tolerance Notation .................. .. .. i, 41
Inserting Tolerance and Datum Values .................................... 411
Adding Inspection Dimensions ................ ... .. oo oo 413
TheBottom Line ........... .. 414
Part 3 « Mastering Advanced Skills .............cociiiiiiiiiiiiiiiiennn. 415
Chapter 12 « Using Attributes ...........coiiiiiiiiiiiieienennnnnn 417
Creating Attributes ......... ... ... 418
Adding Attributes toBlocks ............ . i 418
Copying and Editing Attribute Definitions....................... ... ... ... 421
Turning the Attribute Definitionsintoa Block .............. ... ... ... ... ... 423

Inserting Blocks Containing Attributes ..................... .. ... ... . ... 424



CONTENTS

Editing Attributes ........ .. . . 428
Editing Attribute ValuesOneataTime .................. .. ... .. ... ...... 428
Editing Attribute Text Formats and Properties ............................. 429
Making Global Changes to Attribute Values ............................... 431
Making Invisible Attributes Visible ................... ... ... ... L 432
Making Global Format and Property Changes to Attributes .................. 433
Other Block Attribute Manager Options ................. ... ..., 434
Redefining Blocks Containing Attributes ......................... ... ... ... 435

Extracting and Exporting Attribute Information ..................... ... ... ... 436
Performing the Extraction ............... .. ... ... . . i 436
Extracting Attribute Data to an AutoCAD Table ............................ 441

The Bottom Line ............ . 443

Chapter 13  Copying Existing Drawings from Other Sources ......... 445

Methods for Converting Paper Drawings to AutoCAD Files .................... 445

Importinga RasterImage ............... ... ... ... ... ... L. 446

Working witha RasterImage ............... ... .. ... i 449
Scalinga RasterImage ............ ... . i 449
Controlling Object Visibility and Overlap with Raster Images ................ 450
Adjusting Brightness, Contrast,and Fade .................................. 452
ClippingaRasterImage ................. . i 454
Turning Off the Frame, Adjusting Overall Quality, and

Controlling Transparency ...............oiuiiiiiiiiieeiiieaan. 456

Working with PDF Files ....... ... .. .. 458
ImportingaPDF......... ... 458
Scaling and Osnaps withPDFs .......... ... ... ... .. . o .. 460
Controlling the PDF Display ............. ... i, 461
Importing a PDF as an AutoCAD Drawing ................................. 463
Reconstructing Imported AutoCAD SHX Fonts ............................. 465

Coordinating Geographic Locations ..................... ... ... i, 466
Making Adjustmentstothe Map ............. ... ... . ... ..l 470
Finding Measurements and Distances ..................................... 471

TheBottom Line ....... ... ... . 472

Chapter 14 « Advanced Editing and Organizing ..................... 473

Using External References .......... ... ... .. i 473
Preparing Existing Drawings for External Referencing ...................... 474
Assembling Xrefs to Builda Drawing .................. ... ... ... ... ... 476
Updating Blocksin Xrefs ....... ... ... .. . i 480
Importing Named Elements from Xrefs ................................... 482
Controlling the Xref Search Path . ............ ... ... ... ... ... ... ... 485

Managing Layers ....................... ... 486
Saving and Recalling Layer Settings .................. ... ... ... ... ... 486
Other Tools for Managing Layers ..., 490

Using Advanced Tools: Filter and Quick Select ................................ 492
Filtering Selections .......... ... ... . . i 493

Using Quick Select . ........... 496

XV



XVI

CONTENTS

Using the QuickCalc Calculator ............. ... ... i i, 499
Adding Foot and Inch Lengths and Finding the Sum of Angles ............... 501
Converting Units with QuickCalc ............ ... ... ... ... o L. 503
Using QuickCalc to Find Points .............. ... ... ... ... . ... ... .. 505
Finding Fractional Distances between Two Points .......................... 508
Using QuickCalc While in the Middle of a Command ....................... 510
Storing Expressions and Values .............. ... ... .. . .ol 511
Guidelines for Working with QuickCalc ................ ... ... ... ... ..., 513

The Bottom Line ...... ... .. 515

Chapter 15 « Laying Out Your Printer Qutput ...................... 517

Understanding Model Space and Paper Space ................................. 517
Switching from Model Space to Paper Space ............................... 518
Setting the Size of a Paper Space Layout ................................... 520
Creating New Paper Space Viewports ................. ..., 521
Reaching Inside Viewports ............. ... ... i 523

Working with Paper Space Viewports ............. ... ..o i i 524
Scaling Views in PaperSpace . ............ ... .. i i i 526
Setting Layers in Individual Viewports ................ ... ... ... L 528
Creating and Using Multiple Paper Space Layouts .......................... 531

Creating Odd-Shaped Viewports .............. ... i, 532

Understanding Lineweights, Linetypes, and Dimensions in Paper Space ......... 535
Controlling and Viewing Lineweights in Paper Space ....................... 535
The Lineweight Settings Dialog Box .................. ... ... ... ...... 537
Linetype Scales and Paper Space ............... ... .. ... ... i 537
Dimensioning in Paper Space Layouts . ...................... ... ... ... 538
Other Uses for Paper Space ... .. 541

The Bottom Line ...... ... . 541

Chapter 16 « Making “Smart” Drawings with Parametric Tools ....... 543

Why Use Parametric Drawing Tools? ............ ... ... ... ... ... ... ..., 543

Connecting Objects with Geometric Constraints .............................. 544
Using AutoConstrain to Add Constraints Automatically ..................... 545
Editing a Drawing Containing Constraints ................................ 546
Using Other Geometric Constraints .................. ... ..., 549
Using Constraints in the Drawing Process ................................. 550

Controlling Sizes with Dimensional Constraints .............................. 550
Adding a Dimensional Constraint ............... ... ... ... ... .. .. ... 551
Editing a Dimensional Constraint ................... ... ... ... . ... 553

Using Formulas to Control and Link Dimensions . ............................. 554
Adding a Formula Parameter ................. ... ... .. .. i 555
Testingthe Formula ........... ... ... ... . . 557
Using Other Formulas ......... ... ... ... ... ... o, 557

Editing the Constraint Options .............. ... .. .. ... i ... 559

Putting Constraintsto Use ......... ... ... .. ... .. ... L. 561

The Bottom Line .. ...t e e e e 562



CONTENTS | XVII

Chapter 17 « Using DynamicBlocks .................. ... ciiaat, 563
Exploring the Block Editor ............ ... .. .. ... 563
Opening the Block Editor ................ .. ... ... ... o 563
Editing a Block and Creating New Blocks ........................ ... ... ... 565
Creatinga DynamicBlock ......... .. ... .. 566
Adding aParameter ............... ... 567
Adding an Action ............. 568
Adding anIncrement Value .............. .. ... ... i 570
Editing Parameters and Actions .............. ... ... .. i 572
Keeping an Object Centered .............. ... ... .. ... ... ... ... ..., 572
Using Constraints in Dynamic Blocks ................... ... ... ... ... 574
Adding a List of Predefined Options ............... ... ... ..o i i 578
Creating Multiple Shapes inOneBlock ........... ... ... .. ... .. ... ... ... 582
Rotating Objectsin Unison .............. ... ... 586
Filling in a Space Automatically with Objects .............................. ... 590
Including Block Information with Data Extraction ............................. 591
The Bottom Line ...... ... ... 594
Chapter 18 « Drawing Curves ............ciuieieneennnenencannnss 595
Introducing Polylines ............ ... . .. . 595
DrawingaPolyline ........... ... . ... .. 595
Setting Polyline Options . ........... ... .. . i 597
Editing Polylines .............. . . 598
Setting Pedit Options ........ ... .. ... ... 602
Smoothing Polylines ........... ... .. .. .. 602
Editing Vertices .......... .. 604
Creating a Polyline Spline Curve ............. ... ... ... i .. 613
Using True Spline CUIVES . ...... ...t 615
DrawingaTrueSpline ......... ... ... .. i 616
Understanding the Spline Options .................... ... ... . ..., 617
Fine-Tuning Spline Curves .............. ... . i 619
Marking Divisions on Curves ...t 621
Dividing Objects into Segments of Equal Length ........................... 622
Dividing Objects into Specified Lengths ......................... ... ... ... 624
TheBottom Line ...... ... ... 625
Chapter 19 « Getting and Exchanging Data from Drawings ........... 627
Finding the Area of Closed Boundaries ...................................... 627
Finding the Areaof anObject ........... ... ... ... . i i, 628
Using Hatch Patterns to Find Areas ................... ... ... ... ...... 629
Adding and Subtracting Areas with the Area Command .................... 631
Getting General Information ............... ... ... ... .. i 634
Determining the Drawing’s Status ...................... ... ... ... ...... 635
Keeping Track of Time ......... ... . ... i 636
Getting Information from System Variables ................................ 637

Keeping a Log of Your Activity ............ ... ... ... . i 638



XVIII

CONTENTS

Capturing and Saving Text Data from the AutoCAD Text Window ............ 639
Understanding the Command Window Context Menu ...................... 639
Storing Searchable Information in AutoCAD Files .......................... 640
Searching for AutoCAD Files ........... ... ... ... ... .. ... 641
Recovering Corrupted Files .............. .. ... ... .. 642
Using the DXF File Format to Exchange CAD Data
with Other Programs .......... ... ... 642
Exporting DXFFiles ........ ... . 643
Opening or Importing DXFFiles ............ ... ... . .. ... ... ... ... 644
Using AutoCAD Drawings in Page Layout Programs .......................... 646
Exporting Raster Files .......... ... ... .. .. . 646
Exporting Vector Files . ...... ... ... ... .. 650
Using OLE toImportData ......... ... ... . 652
Editing OLE Links . ........ 654
Importing Worksheets as AutoCAD Tables . ................................ 655
Understanding Options for Embedding Data............................... 657
Using the Clipboard to Export AutoCAD Drawings ......................... 657
The Bottom Line ...... ... ... 658
Part 4 « 3D ModelingandImaging ..............ciiiiiiiiiiiiiiienenennn. 659
Chapter 20 « Creating 3D Drawings ..............ccciviiieiennnn.. 661
Getting to Know the 3D Modeling Workspace ................................ 661
Drawing in 3D Using Solids ........... ... .. i 663
Adjusting Appearances . ................iii i 664
Creatinga3D Box ........ ... 665
Editing 3D Solids with Grips . ............ .. i 666
Constraining Motion with the Gizmo ................... ... ............... 667
Rotating Objects in 3D Using Dynamic UCS ............................... 668
Drawing ona 3D Object’sSurface .................. ... ..o i 670
Pushing and Pulling Shapes froma Solid .................................. 672
Making Changes to Your Solid ............... ... ... .. .. i 674
Creating 3D Forms from 2D Shapes . ............. ... ... . ... 676
Isolating Coordinates with Point Filters ...................................... 681
Moving Around Your Model ....... ... .. ... . 684
Finding Isometric and Orthogonal Views .................................. 684
Rotating Freely Around Your Model ...................................... 685
Changing Your View Direction ............... ... ... . . .. 686
Using SteeringWheels ......... ... ... 688
Changing Where You Are Looking .................... ... ..., 690
Flying through Your View ....... ... ... ... ... ... . ... .. L. 690
Changing from Perspective to Parallel Projection ........................ ... 691
Getting a Visual Effect .......... ... . 692
Using Visual Styles ......... ... ... . . 692
Creating a Sketched Look with Visual Styles ............................... 693

In-Canvas Viewport Controls ............ ... ... i .. 696



CONTENTS
Turning a 3D View into a 2D AutoCAD Drawing .............................. 696
Using the Point Cloud Feature ............... ... ... ... ... .. .. ........ 699
TheBottom Line ........ ... . ... 700
Chapter 21 « Using Advanced 3D Features ...........ccoveienennnnn. 703
Setting Up AutoCAD for thisChapter.................... ... ... ... ... ... 703
Mastering the User Coordinate System ....................................... 704
Defininga UCS ... ... o 705
Saving a UCS ... ... 707
Workingina UCS ... ... . 708
Building 3D Parts in Separate Files .. ............ ... ... ... ... ..ol 709
Understanding the UCSOptions ............. ... 712
UCS Based on Object Orientation ............. ... ... ... 712
UCS Based on Offset Orientation ..................... ... ..., 714
UCS Rotated Around an AXis ..............iiiiiiii .. 715
Orientinga UCSinthe View Plane . ................... ... ... ... ...... 717
Manipulating the UCSIcon ............ ... i 717
Savinga UCSwitha View ......... ... ... .. .. i i i, 718
Using Viewports to Aid in 3D Drawing .................. ... ... ... .. 719
Using the Array Tools . . ... 723
Making Changes to an Associative Array ...............c.ooiiiiiiiiiiinn... 724
Creating Complex 3D Surfaces ............... i 724
LayingOuta3D Form ....... ... ... ... 725
Spherical and Cylindrical Coordinate Formats ............................. 726
Usinga3DPolyline ......... ... .. i 727
Creatinga Curved 3D Surface ........... ... ... i i i 729
Converting the Surfaceintoa Solid .............. ... ... ... ... ... .. ... ... 733
Shaping the Solid ........ ... ... .. . . 733
Finding the Interference between Two Solids . .............................. 735
Creating Tubes with the Sweep Tool .................... ... ... .. ... ... ... 738
Using Sweep to Create Complex Forms ................ ... ... ... ... ... 740
Creating Spiral Forms . ........... . . 742
Creating Surface Models .......... ... .. ... ... . 745
Slicing a Solid witha Surface ............ ... ... ... .. . i 747
Finding the VolumeofaCut .............. ... ... ... . i i 748
Understanding the Loft Command ................... ... ... ... ...... 750
Moving Objects in3D Space ...t 754
Aligning Objects in3D Space ............ ... 754
Moving an Objectin3D ...... ... ... ... ... . . 756
Rotating an Objectin3D ....... ... ... i 757
TheBottom Line ........... .. . 758
Chapter 22 . Editing and Visualizing3D Solids ..................... 759
Understanding Solid Modeling ......... ... .. .. .. ... ... . i 759
Creating Solid Forms ............ ... . . 762
Joining Primitives ........... ... .. . 762

Cutting Portions OutofaSolid .............. ... ... . .. i 763

XIX



XX

CONTENTS

Creating Complex Solids .......... ... .. . i 766
Tapering an Extrusion ................. ... .. o oo 766
Sweeping a ShapeonaCurvedPath .................. ... ... ... ... ... 767
Revolving a Polyline ......... ... .. ... . 768

Editing Solids . ... ... 771
Splitting a Solid into Two Pieces ............. ... ... ... i, 771
Rounding Corners with the Fillet Tool ................. ... ... ... ... ... 772
Chamfering Corners with the Chamfer Tool ............................... 773
Using the Solid-Editing Tools ............... ... ... .. .. oo, 775

Streamlining the 2D Drawing Process .................... ... ... ... ... 784
Drawing Standard Top, Front, and Right-Side Views ........................ 784
Creating 2D Drawings with the Base View Command ....................... 787
Adding Dimensions and Notesina Layout ................................ 792
Using Visual Styles witha Viewport .......... ... .. ... . ... .. ..., 793

Visualizing Solids . ......... .. . 794

The Bottom Line . ... e e e e 804

Chapter 23 « Exploring 3D Mesh and Surface Modeling .............. 805

Creatinga Simple3DMesh ........ ... ... .. i 805
Creating a Mesh Primitive ......... ... ... .. ... ... . .. i 806
Understanding the PartsofaMesh ................... ... ... ... ... ... 807
SmoothingaMesh ....... ... ... .. .. 808

Editing Facesand Edges ........... ... ... ... . . . . i 809
Stretching Faces .............. .. . . 810
MovinganEdge ............. 813
Adding More Faces .......... ... 816
Rotatingan Edge ......... ... ... . . 818
AddingaCrease ... 820
Splitting and ExtrudingaMesh Face .................. ... ... . ... ... ... 822

Creating Mesh Surfaces .......... ... ... i 825
Revolved Surface ........... . 825
EdgeSurface ....... ... . 826
Ruled SUrface . ... 827
Tabulated Surface . ... 828

Converting Meshes to Solids . .......... ... ... .. i i i 829

Understanding 3D Surfaces . ........... ... i i 830

Editing Surfaces . ...... ... .. 832
Using Extrude, Surface Trim, and Surface Fillet . ............ ... ... ... ... ... 834
Using Surface Blend, Patch, and Offset .................................... 836
Understanding Associativity ............. .. ... ... 840
Editing with Control Vertices ............. ... ... ... o i .. 843
Editing withthe CVEditBar .......... ... .. ... ... ... o .. 846
Making Holes in a Surface with the Project Geometry Panel ................. 849
Visualizing Curvature: Understanding the Analysis Panel ................... 849

The Bottom Line . ... 852



CONTENTS | XXI

Part 5 « Customization and Integration ................ ... i, 853

Chapter 24 « Customizing Toolbars, Menus, Linetypes, and

HatchPatterns ...........c.ciiiiiiiiiiiiinieneneennnenencananns 855
Using Workspaces . ... 855
Customizing the User Interface ............. .. ... ... . ... ... ... ... ... 857
Taking a Quick Customization Tour................... ... ... ... ...... 857
Understanding the Customizations In All Files Panel ....................... 861
Getting the Overall View ....... ... ... . i i 864
Finding Commands in the Command List ................................. 866
Opening Preview, Button Image, and Shortcuts ............................. 866
Getting to the Core of Customization in the Properties Group ................ 867
Creating Your Own Ribbon Panelsand Menus ............................. 868
Customizing Ribbon Panel Tools ..................... ... ... ... ...... 869
Creating Macros in Toolsand Menus .................... ... coiiiiiiinn... 873
Pausing for User Input ......... ... ... . . . 874
Opening an Expanded Text Box for the Macro Option ....................... 875
Editing Keyboard Shortcuts ........... .. ... ... . . 876
Saving, Loading, and Unloading Your Customizations ......................... 878
Understanding the DIESEL Macro Language ................................. 881
Using DIESEL at the Command Line .................. ... ... . ... ...... 881
Using DIESEL ina Custom MenuMacro ..., 882
Using DIESEL as a Menu Bar Option Label ................................ 883
Using DIESEL and Fields to Generate Text ................................. 886
Creating Custom Linetypes......... ... i 887
Viewing Available Linetypes ............. ... . i i 887
Creatinga New Linetype ....... ... i i 888
Understanding the Linetype Code ............ ... ... .. ... ... .. 889
Creating Complex Linetypes ............. .. i, 890
Creating Hatch Patterns . .......... ... ... .. .. .. i 892
TheBottom Line ....... ... .. ... 894
Chapter 25 « Managing and Sharing Your Drawings ................. 897
Sharing DrawingsOnline .......... ... ... ... .. . i i 897
Sharing Project Files with eTransmit .................. ... ... .. ... ... ... 898
Protecting AutoCAD Drawing Files ................... ... ... ... ... ... 902
Publishing Your Drawings .............. ... ... 906
Exchanging Drawing Sets ............. ... .. ... . i 906
Exploring Other Publish Options ............. ... .. ... ... .. oL, 908
Creating a PDF or DWF File by Using the Plot Dialog Box .................... 910
Sharing Files with A360 Drive ............ ... .. i 912
Getting Started with A360 Drive ......... ... ... ... .. .. .. 912
Viewing Files and Adding Comments ..................................... 914
Sharing Files .. ... ... 915
Opening and Saving Files Directly to A360 Drive ........................... 916

Collaborating with Others Using DesignFeed .............................. 917



XXII

CONTENTS

Adding Hyperlinks to Drawings ............. ... .. ... o i ... 920
Creating Hyperlinks .......... ... .. . 920
Editing and Deleting Hyperlinks ............. ... ... ... . ... ... ...... 922
Taking a Closer Look at the Hyperlink Options . ............................ 922

Managing Your Drawings with DesignCenter and the Tool Palettes ............. 923
Getting Familiar with DesignCenter ................... ... ................ 924
Opening and Inserting Files with DesignCenter ............................ 927
Finding and Extracting the Contents of a Drawing .......................... 928
Exchanging Data between Open Files .................. ... ... . ... ... ... 931
Loading Specific Files into DesignCenter .................................. 932
Customizing the Tool Palettes with DesignCenter .......................... 932

Establishing Office Standards .................. ... ... ... .. L 936
Establishing Layering and Text Conventions ............................... 936
Checking Office Standards . .............. .. ... i i 937

Converting Multiple Layer Settings . ............. ... ... ... ... o .. 942
Exploring Other Layer Translator Options ................................. 944

The Bottom Line ...... ... ... 945

Part 6 e Appendixes . ... ..ot iiiiiiiiiiiiinitnentieeetaencanneneanenn 947

Appendix A e TheBottomLine ..............coiiiiiiiiiiiiinnnn. 949

Chapter 1: Exploring the Interface ............... ... ... ... .. ... ... ... ... 949

Chapter 2: Creating Your First Drawing ............................. ... ...... 950

Chapter 3: Setting Up and Using the Drafting Tools ........................... 951

Chapter 4: Organizing Objects with Blocks and Groups ........................ 951

Chapter 5: Keeping Track of Layers and Blocks ................................ 952

Chapter 6: Editing and Reusing Data to Work Efficiently .................... ... 953

Chapter 7: Mastering Viewing Tools, Hatches, and External References .......... 954

Chapter 8: Introducing Printing, Plotting, and Layouts ......................... 954

Chapter 9: Adding Text to Drawings ............. ... ... .. ... 955

Chapter 10: Using Fieldsand Tables . ............. ... ... ... ... o ... 956

Chapter 11: Using Dimensions ............ ..., 957

Chapter 12: Using Attributes . ......... ... ... . ... ... .. 958

Chapter 13: Copying Existing Drawings from

Other SoUrces .......... ...t 959

Chapter 14: Advanced Editing and Organizing . ............................... 960

Chapter 15: Laying Out Your Printer Output .................................. 960

Chapter 16: Making “Smart” Drawings with

Parametric Tools ...... ... ... 961

Chapter 17: Using DynamicBlocks ............. ... ... ... . ... ... ... 962

Chapter 18: Drawing Curves ........... ...ttt 963

Chapter 19: Getting and Exchanging Data

from Drawings ....... ... 965

Chapter 20: Creating 3D Drawings .............. ..., 965

Chapter 21: Using Advanced 3D Features ................... ... ... .. ........ 966

Chapter 22: Editing and Visualizing 3D Solids ................................ 968



CONTENTS | XXIII

Chapter 23: Exploring 3D Mesh and Surface Modeling ......................... 969
Chapter 24: Customizing Toolbars, Menus, Linetypes, and Hatch Patterns ........ 969
Chapter 25: Managing and Sharing Your Drawings ............................ 971
Appendix B ¢ Installing and Setting Up AutoCAD ................... 973
Before Installing AutoCAD ...... ... ... ... 973
Proceeding with the Installation ................. ... ... ... ... ... ... ...... 973
Configuring AWtoCAD . ... .. 974
The Files Tab . . ..ot e e e 974
TheDisplay Tab .......... ... 978
TheOpen AndSaveTab ......... ... ... ... . i i i 980
The Plotand Publish Tab ............ . .. i 983
TheSystem Tab . ... 983
The User Preferences Tab . ....... ... i i 985
The Drafting Tab ............. . . 988
The3D Modeling Tab ........ ... ... 989
The Selection Tab . .. ..ot 993
The Profiles Tab . ... ..o e e 996
The Online Tab . .. ... e e e 997
Configuring the Tablet Menu Area ........... ... ... ... ... ... 998
Turning On the Noun/Verb Selection Method ................................ 999
Turning on the Grips Feature ............... .. ... ... ... ... ... .. ..., 999
Setting Up the Tracking Vector Feature ...................................... 999
Adjusting the AutoCAD 3D Graphics System ................................ 1000
Finding Folders That Contain AutoCAD Files ................................ 1001
Setting Up AutoCAD with a White Background .............................. 1001
Appendix C « The Autodesk AutoCAD 2018 Certification ............ 1003






Introduction

Welcome to Mastering AutoCAD 2018 and AutoCAD LT 2018. As many readers have already dis-
covered, this book is a unique blend of tutorial and reference, which includes everything that
you need to get started and stay ahead with Autodesk® AutoCAD® software. With this edition,
you get coverage of the latest features of both AutoCAD 2018 and AutoCAD LT® 2018 software
along with detailed information on existing features.

How to Use This Book

Rather than just showing you how each command works, this book shows you AutoCAD 2018
in the context of a meaningful activity. You'll learn how to use commands while working on an
actual project and progressing toward a goal. This book also provides a foundation on which
you can build your own methods for using AutoCAD and become an AutoCAD expert. For
this reason, we haven't covered every single command or every permutation of a command
response. You should think of this book as a way to get a detailed look at AutoCAD as it’s used
on a real project. As you follow the exercises, we also encourage you to explore AutoCAD on
your own, applying the techniques that you learn to your own work.

Both experienced and beginning AutoCAD users will find this book useful. If you aren’t an
experienced user, the way to get the most out of this book is to approach it as a tutorial—chapter by
chapter—at least for the first two parts of the book. You'll find that each chapter builds on the skills
and information that you learned in the previous one. To help you navigate, the exercises are shown
in numbered steps. To address the needs of all readers worldwide, the exercises provide both
Imperial (feet/inches) and metric measurements. Some exercises use generic units of measurement,
and if the focus of the exercise is not dependent on the measurement system, Imperial is used.

After you've mastered the material in Part 1 and Part 2, you can follow your interests and
explore other parts of the book in whatever order you choose. Part 3 takes you to a more
advanced skill level. There you'll learn more about storing and sharing drawing data and how
to create more complex drawings. If you're interested in 3D, check out Part 4. If you want to start
customizing right away, go to Part 5. You can check out Chapter 25 at any time because it gives
you general information about sharing AutoCAD files with your co-workers and consultants.
You can also use this book as a ready reference for your day-to-day problems and questions
about commands. “The Bottom Line” section at the end of each chapter will help you review
and look at different ways to apply the information that you've learned. Experienced users will
also find this book a handy reference tool.

Finally, you can learn more about AutoCAD through the author-supplied bonus chapters found
atwww.omura.com/chapters. For example, if you run into problems using AutoCAD, see the sec-
tion “When Things Go Wrong” in Bonus Chapter 3, “Hardware and Software Tips.” To delve into
the details of printers and plotting, check out Bonus Chapter 5, “Understanding Plot Styles.”


http://www.omura.com/chapters
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AutoCAD and AutoCAD LT 2018

Autodesk has released AutoCAD 2018 and AutoCAD LT 2018 simultaneously. Not surprisingly,
theyre nearly identical in the way they look and work. You can share files between the two pro-
grams with complete confidence that you won't lose data or corrupt files. The main differences
are that AutoCAD LT doesn’t support all of the 3D functions of AutoCAD 2018, nor does it sup-
port the customization tools of AutoLISP® or the NET Framework. But AutoCAD LT still has
plenty to offer in both the productivity and customization areas. Because they're so similar, we
can present material for both programs with only minor adjustments.

When a feature is discussed that is available only in AutoCAD 2018, you'll see the AutoCAD
Only icon. For the purposes of this publication, the “ACAD only” icon means that the relevant
(or adjacent) content applies only to AutoCAD software and not to AutoCAD LT software.

You'll also see warning messages when tutorials vary between AutoCAD 2018 and AutoCAD
LT. If only minor differences occur, you'll see either a warning message or directions embedded
in the exercise indicating the differences between the two programs.

We've also provided workaround instructions wherever possible when AutoCAD LT doesn’t
offer a feature found in AutoCAD 2018.

Getting Information Fast

In each chapter, you'll find extensive tips and discussions in the form of sidebars set off from
the main text. These provide a wealth of information that we have gathered over years of using
AutoCAD on a variety of projects in different office environments. You may want to browse
through the book and read these boxes just to get an idea of how they might be useful to you.

Another available quick reference is Bonus Chapter 4, “System Variables and Dimension
Styles.” It contains descriptions of all the dimension settings with comments on their uses. If
you experience any problems, you can consult the section “When Things Go Wrong” in Bonus
Chapter 3, “Hardware and Software Tips.”

The Mastering Series

The Mastering series from Sybex provides outstanding instruction for readers with intermediate
and advanced skills in the form of top-notch training and development for those already work-
ing in their field, and clear, serious education for those aspiring to become pros. Every Mastering
book includes the following:

¢ Skill-based instruction with chapters organized around real tasks rather than abstract con-
cepts or subjects

¢ Self-review test questions so that you can be certain you're equipped to do the job right

What to Expect

Mastering AutoCAD 2018 and AutoCAD LT 2018 is divided into five parts, each representing a
milestone in your progress toward becoming an expert AutoCAD user. Here is a description of
those parts and what they will show you.
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Part 1: The Basics

As with any major endeavor, you must begin by tackling small, manageable tasks. In this first
part, you'll become familiar with the way that AutoCAD looks and feels.

¢ Chapter 1, “Exploring the Interface,” shows you how to get around in AutoCAD.

¢ Chapter 2, “Creating Your First Drawing,” details how to start and exit the program and
how to respond to AutoCAD commands.

¢ Chapter 3, “Setting Up and Using the Drafting Tools,” tells you how to set up a work area,
edit objects, and lay out a drawing.

¢ Chapter 4, “Organizing Objects with Blocks and Groups,” explores some tools unique
to CAD: symbols, blocks, and layers. As you're introduced to AutoCAD, you'll also get a
chance to make some drawings that you can use later in the book and perhaps even in your
future projects.

¢ Chapter 5, “Keeping Track of Layers and Blocks,” shows you how to use layers to keep simi-
lar information together and object properties such as linetypes to organize things visually.

Part 2: Mastering Intermediate Skills
After you have the basics down, you'll begin to explore some of the subtler qualities of AutoCAD.

¢ Chapter 6, “Editing and Reusing Data to Work Efficiently,” tells you how to reuse drawing
setup information and parts of an existing drawing,.

¢ Chapter 7, “Mastering Viewing Tools, Hatches, and External References,” details how to
use viewing tools and hatches and how to assemble and edit a large drawing file.

¢ Chapter 8, “Introducing Printing, Plotting, and Layouts,” shows you how to get your draw-
ing onto hard copy.

¢ Chapter9, “Adding Text to Drawings,” tells you how to annotate your drawing and edit
your notes.

¢ Chapter 10, “Using Fields and Tables,” shows you how to add spreadsheet functionality to
your drawings.

¢ Chapter 11, “Using Dimensions,” gives you practice in using automatic dimensioning
(another unique CAD capability).

Part 3: Mastering Advanced Skills

At this point, you'll be on the verge of becoming a real AutoCAD expert. Part 3 is designed to
help you polish your existing skills and give you a few new ones.

¢ Chapter 12, “Using Attributes,” tells you how to attach information to drawing objects and
how to export that information to database and spreadsheet files.

¢ Chapter 13, “Copying Existing Drawings from Other Sources,” details techniques for
transferring paper drawings to AutoCAD. You'll also learn how to include aerial and map
views in your drawings.
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Chapter 14, “Advanced Editing and Organizing,” is where you'll complete the apartment
building tutorial. During this process, you'll learn how to integrate what you've learned so
far and gain some tips on working in groups.

Chapter 15, “Laying Out Your Printer Output,” shows you the tools that let you display
your drawing in an organized fashion.

Chapter 16, “Making ‘Smart’ Drawings with Parametric Tools,” introduces you to paramet-
ric drawing. This feature lets you quickly modify a drawing by changing a few parameters.

Chapter 17, “Using Dynamic Blocks,” shows you how you can create blocks that can be
edited with grips without having to redefine them.

Chapter 18, “Drawing Curves,” gives you an in-depth look at some special drawing objects,
such as splines and fitted curves.

Chapter 19, “Getting and Exchanging Data from Drawings,” is where you'll practice get-
ting information about a drawing and learn how AutoCAD can interact with other applica-
tions, such as spreadsheets and page layout programs. You'll also learn how to copy and
paste data.

Part 4: 3D Modeling and Imaging

Although 2D drafting is the workhorse application in AutoCAD, its 3D capabilities give you a
chance to expand your ideas and look at them in a new light.

*

*

Chapter 20, “Creating 3D Drawings,” covers basic features for creating three-dimensional
drawings.

Chapter 21, “Using Advanced 3D Features,” introduces you to some of the program’s more
powerful 3D capabilities.

Chapter 22, “Editing and Visualizing 3D Solids,” takes a closer look at 3D solids and how
they can be created, edited, and displayed in AutoCAD 2018.

Chapter 23, “Exploring 3D Mesh and Surface Modeling,” introduces you to free-form 3D
modeling using mesh and surface objects. With the latest additions to the 3D feature setin
AutoCAD, there isn’t anything you can’t model in 3D.

Part 5: Customization and Integration

One of the greatest strengths of AutoCAD is its openness to customization, which you'll explore
in this section.

*

Chapter 24, “Customizing Toolbars, Menus, Linetypes, and Hatch Patterns,” shows you
how to use workspaces, customize the user interface, and create custom linetypes and
hatch patterns. You'll also be introduced to the DIESEL macro language.

Chapter 25, “Managing and Sharing Your Drawings,” shows you how to adapt AutoCAD
to your own work style. You'll learn about the tools that help you exchange drawings with
others and how to secure your drawings to prevent tampering.
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Part 6: Appendixes

Finally, this book has several appendixes.

¢ Appendix A, “The Bottom Line,” contains the solutions to the book’s “Master It” review
questions.

¢ Appendix B, “Installing and Setting Up AutoCAD,” contains an installation and configu-
ration tutorial. If AutoCAD isn't already installed on your system, follow the steps in this
tutorial before starting Chapter 1.

¢ Appendix C, “The Autodesk AutoCAD 2018 Certification,” shows you where in the book
the learning objectives are covered for the Certified User and Certified Professional Exams.
If you want to get certified, this information will be very useful.

Where to Get the Exercise Files and Bonus Chapters

Many of the exercises in this book make use of sample files that you can download from the fol-
lowing website: www. sybex.com/go/masteringautocad2018. With these files, you can pick up
an exercise anywhere you like without having to work through the book from front to back. You
can also use these sample files to repeat exercises or to just explore how files are organized and
put together. You can also download additional bonus chapters that cover other AutoCAD fea-
tures from www.omura.com/chapters. The bonus chapters are as follows:

¢ Bonus Chapter 1, “Using the Express Tools,” gives you a gentle introduction to the world
of AutoCAD customization. You'll learn how to load and use existing Express tools that
expand the software’s functionality, and you'll be introduced to AutoLISP as a tool to cre-
ate macros.

¢ Bonus Chapter 2, “Exploring AutoLISP,” is a primer to this popular macro language found
in AutoCAD. You'll learn how you can create custom commands built on existing ones and
how you can retrieve and store locations and other data.

¢ Bonus Chapter 3, “Hardware and Software Tips,” provides information about hardware
related to AutoCAD. It also offers tips on improving the performance of AutoCAD and
troubleshooting and provides more detailed information on setting up the plotting
feature.

¢ Bonus Chapter 4, “System Variables and Dimension Styles,” provides a reference to dimen-
sion style settings.

¢ Bonus Chapter 5, “Understanding Plot Styles,” discusses methods for controlling line-
weights and shading in your printer output.

¢ Bonus Chapter 6, “Rendering 3D Drawings,” shows how you can use AutoCAD to produce
lifelike views of your 3D drawings.

¢ Bonus Chapter 7, “Keeping a Project Organized with Sheet Sets,” shows you how to use the
Sheet Set Manager to simplify your file management. By using the Sheet Set Manager, you
can automate some of the tedious drawing coordination tasks.


http://www.sybex.com/go/masteringautocad2018
http://www.omura.com/chapters
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THE AUTOCAD FREE TRIAL

If you don’t have AutoCAD, you can download and install a trial version from the Autodesk website
(www . autodesk.com). Be aware that the trial is good for only 30 days and cannot be reinstalled
to add time to the trial period—don’t start to use it until you're certain you’ll have plenty of free
time to practice using AutoCAD.

FREE AUTODESK SOETWARE FOR STUDENTS AND EDUCATORS

The Autodesk Education Community is an online resource with more than five million members
that enables educators and students to download—for free (see the website for terms and
conditions)— the same software used by professionals worldwide. You can also access additional
tools and materials to help you design, visualize, and simulate ideas. Connect with other learners to
stay current with the latest industry trends and get the most out of your designs. Get started today
at www.autodesk.com/joinedu.

The Minimum System Requirements

This book assumes that you have a Windows-based PC with at least a dual-core processor or
equivalent CPU. Your computer should have at least one DVD drive and a hard disk with 4 GB
or more of free space for the AutoCAD program files and about 200 MB of additional space for
sample files and the workspace. In addition to these requirements, you should have enough free
disk space to allow for a Windows virtual memory page file that is about 1.5 times the amount
of installed RAM. Consult your Windows manual or Bonus Chapter 3, “Hardware and Software
Tips,” available at www.omura.com/chapters, for more on virtual memory.

AutoCAD 2018 runs best on systems with at least 4 GB or more of RAM. Your computer
should also have a high-resolution monitor and an up-to-date display card. An HD/VGA dis-
play with a resolution of 1366x768 or greater will work fine with AutoCAD, but if you want to
take full advantage of the 3D features, you should have a 128 MB or greater, OpenGL-capable,
workstation-class graphics card. We also assume that you're using a mouse and have the use
of a printer or a plotter. Finally, you'll need an Internet connection to take full advantage of the
support offerings from Autodesk.

If you want a more detailed explanation of hardware options with AutoCAD, see Bonus
Chapter 3. You'll find a general description of the available hardware options and their signifi-
cance to AutoCAD.

Doing Things in Style
Much care has been taken to see that the stylistic conventions in this book—the use of uppercase
or lowercase letters, italic or boldface type, and so on—are the ones most likely to help you learn

AutoCAD. On the whole, their effect should be subliminal. However, you may find it useful to
be conscious of the following rules:

¢ Menu selections are shown by a series of options separated by the > symbol (for example,
choose File > New). These are typically used to show selections from a context menu or the
Application menu, which you will learn about in Chapter 1.


http://www.autodesk.com
http://www.autodesk.com/joinedu
http://www.omura.com/chapters
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¢ Keyboard entries are shown in boldface (for example, enter Rotate.]).
¢ Command-line prompts are shown in a monospaced font (for example, Select objects:).

For most functions, this book describes how to select options from Ribbon panels and the
Application menu. In addition, where applicable, we include related keyboard shortcuts and
command names in parentheses. These command names provide continuity for readers who are
accustomed to working at the Command prompt.

New Features of AutoCAD 2018

AutoCAD 2018 has a long list of new features, many of which are aimed at making your work
easier and faster. Some features, like Autodesk 360® and Autodesk Exchange, are web tools that
help you share your work, keep up with the latest on AutoCAD, and discuss issues you may be
having. Here are some of the new features that we cover in this book:

¢ Resizable dialog boxes
Improved 2D and 3D display quality and performance
Improved Move and Copy tools

*
*
¢ PDF vector import
¢ Center mark dimensioning tool
*

3D printing support

Contact the Authors

We hope that Mastering AutoCAD 2018 and AutoCAD LT 2018 will be of benefit to you and that,
after you've completed the exercises, you'll continue to use the book as a reference. If you have
comments, criticism, or ideas about how the book can be improved, you can email us at the fol-
lowing addresses:

George Omura: george.omura@gmail.com
Brian C. Benton: bbenton@cad-a-blog.com

If you find errors, please let our publisher know. Visit the book’s web page,
www. sybex.com/go/masteringautocad2018, and click the Errata link to find a form to
use to identify the problem.

And thanks for choosing Mastering AutoCAD 2018 and AutoCAD LT 2018.


mailto:george.omura@gmail.com
mailto:bbenton@cad-a-blog.com
http://www.sybex.com/go/masteringautocad2018
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Before you can start to use the new capabilities of the AutoCAD® 2018 software, you must

become familiar with the basics. If you're completely new to AutoCAD, you'll want to read this
first chapter carefully. It introduces you to many basic operations of AutoCAD, such as open-
ing and closing files, getting a close-up look at part of a drawing, and changing a drawing. If
you're familiar with earlier versions of AutoCAD, you should review this chapter anyway to get
acquainted with the features that you haven't already used.

Autodesk releases new versions of AutoCAD every year. Part of this strategy is to introduce
improvements that focus on a particular category of features. AutoCAD 2018 offers updates that
cover a wide range of features. The user interface is easier to customize. There are more ways
to access drafting and layer settings. External references have been revamped to allow easy
modification to file paths. Font recognition in PDFs has been improved, and display performance
has been enhanced. Finally, a new 2018 file format has been updated to accommodate these new
features. Before you begin the exercises in this chapter, make sure that you have loaded the
sample files from this book’s web page at www. sybex.com/go/masteringautocad2018. See the
introduction for details. If you have purchased the e-book version, please see the introduction
for instructions on how to download the sample files.

In this chapter, you will learn to

¢ Use the AutoCAD window

¢ Getacloser look with the Zoom command
¢ Savea file as you work
*

Make changes and open multiple files

Taking a Guided Tour

First, you'll get a chance to familiarize yourself with the AutoCAD screen and how you com-
municate with AutoCAD. As you do the exercises in this chapter, you'll also get a feel for how
to work with this book. Don’t worry about understanding or remembering everything you see
in this chapter. You'll get plenty of opportunities to probe the finer details of the program as
you work through the later chapters. To help you remember the material, we have included a
brief set of questions at the end of each chapter. For now, just enjoy your first excursion into
AutoCAD.


http://www.sybex.com/go/masteringautocad2018

4 |CHAPTER1 EXPLORING THEINTERFACE

AUTOCAD REFERENCES IN THIS BOOK

In this chapter and throughout the rest of the book, when we say AutoCAD, we mean both AutoCAD
onLY and AutoCAD LT®. Some topics apply only to AutoCAD. In those situations, you'll see an icon indi-
cating that the topic applies only to AutoCAD and not to AutoCAD LT. If you're using AutoCAD LT
2018, these icons can help you focus on the topics that are more relevant to your work by letting
you skim over items that do not apply.

AutoCAD 2018 is designed to run on Windows 7, Windows 8, Windows 8.1, and Windows 10. This
book was written using AutoCAD 2018 running on Windows 7 Professional.

Launching AutoCAD

If you've already installed AutoCAD (see Appendix B, “Installing and Setting Up AutoCAD”)
and are ready to jump in and take a look, proceed with the following steps to launch the
program:

1. Choose Start > All Programs > Autodesk > AutoCAD 2018 > AutoCAD 2018. You can
also double-click the AutoCAD 2018 icon on your Windows Desktop. AutoCAD LT users
will use AutoCAD LT 2018 in place of AutoCAD 2018.

2. The AutoCAD Start tab appears, offering options to open existing drawings or to create a
new drawing. You may also see the Design Feed panel, which allows you to use a cloud-
based collaboration feature. Click the Start Drawing thumbnail in the left side of the view
under “Get Started” (see Figure 1.1).

FIGURE 1.1 " 3 ‘Autodesk AutoCAD e . R
The Start tab oﬁers Home  Insert Annotate Parametric View Manage Output Add-ins X s BIM 360 Performance
easy access to previ- ) ) i

ous work.

Modify ~ Annotation v

Get Started Recent Documents Notifications

You can improve
graphics performance by
turning Hardware

\m ] ] E = Acceleration on.
]

| 04b-bath

Graphics Performance...

Bl Fioor Plan Sample

Start Drawing

h/ Welcome George!

Data Extraction and Multileaders

Sample S <) ‘ A360

Send Feedback
Help us improve our products

Send Feedback
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3. The AutoCAD window displays a blank default document named Drawingl.dwg. Users
may see the Sheet Set Manager palette to the left of the AutoCAD window. In brand-
new installations, you will see the Design Feed panel. Close the Design Feed panel for
now. AutoCAD LT users may see the Info palette to the left of the AutoCAD window.

If you're using the trial version, you'll see the Product License Activation window before
step 2. This window shows you the number of days you have left in the trial version. You can
also activate the product here if you purchase a license. Click the Try button to continue opening
the program. Now let’s look at the AutoCAD window in detail. Don’t worry if it seems like a lot
of information. You don’t have to memorize it, but by looking at all of the parts, you'll be aware
of what is available in a general way.

The AutoCAD Window

Certification 1 he AutoCAD program window is divided into several parts:

Objective L
Application menu

Quick Access toolbar

InfoCenter

Ribbon

Drawing tabs

Drawing area

UCSicon (User Coordinate System icon)
Viewport controls

ViewCube®

Navigation bar

® ¢ 6 6 O 6 O o o o

Command window
Status bar

Figure 1.2 shows a typical layout of the AutoCAD program window. You can organize the
AutoCAD window into any arrangement you want and save it as a workspace. You can save and
recall a workspace at any time using the Workspace Switching tool in the Quick Access tool-
bar. (You'll learn more about this tool in the next chapter.) The default workspace in Figure 1.2
is called the Drafting & Annotation workspace, and it is one of several workspaces built into
AutoCAD.
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FIGURE 1.2 Application Ribbon
A typical arrange- menu
ment of the elements Quick Access toolbar InfoCenter
in the AutoCAD
window

i

B E——— 5
ucs Viewport Status Command Drawing ViewCube  Navigation
controls bar window area bar
AUTOCAD FOR 3D

For 3D modeling work, AutoCAD offers the 3D Modeling workspace and 3D drawing templates. The
combination of these two features can make AutoCAD look like a very different program, but beneath
the different appearance, the underlying program is the same. You’ll learn more about workspaces
and templates later in this chapter and in Chapter 24, “Customizing Toolbars, Menus, Linetypes, and
Hatch Patterns.” Part 4 of this book shows you the 3D features and tools of AutoCAD in more detail.

In the upper-left corner of the AutoCAD program window, the red AutoCAD icon displays
the Application menu, which offers a set of options not directly related to drawing; we’ll elabo-
rate on this menu in the next section. The Quick Access toolbar at the top of the drawing area
(shown in Figure 1.3) includes the basic file-handling functions, which you find in nearly all
Windows programs. The InfoCenter is the AutoCAD online help facility; you'll learn more
about it in Chapter 2, “Creating Your First Drawing.” The Ribbon uses icons to provide nearly all
of the commands that you'll need; you'll learn more about it in the section “Using the Ribbon”
later in this chapter.

FIGURE 1.3 Quick Access toolbar InfoCenter
The Quick Access tool-

bar, featuring basic Ribbon tabs

Windows file-handling  gippon panels { e

functions, appears |

above the Ribbon.
Ribbon panel title bars
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The drawing area occupies most of the screen. Everything you draw appears in this area.
As you move your mouse around, crosshairs appear to move within the drawing area. This
is the drawing cursor that lets you point to locations in the drawing area. You'll get your first
chance to work with the drawing area later in the section “Picking Points in the Drawing
Area.”

Just above the drawing area are the Drawing tabs that let you create new drawings or switch
between open drawings in a way similar to popular web browsers. Notice the X in the cur-
rent tab, which lets you close the current drawing, and the plus icon just to the right of the tab,
which lets you create a new drawing or open an existing one. When you click the plus icon, a
new drawing tab appears that you can save as a new file. Right-click the plus icon and a context
menu opens that offers you the option to open an existing drawing or to create a new one in the
form of an additional tab by using a template.

If you hover over the Drawing tab, you'll see preview images of the model and layouts of the
drawing. You'll learn more about model and layout spaces later in this chapter.

Within the drawing area, you see several items along the side and in the corners. The UCS
icon appears in the lower-left corner. You'll learn more about the UCS icon in a moment. In the
upper-right corner, you see the ViewCube. The ViewCube is primarily for 3D modeling, and we
look at those techniques in Chapter 20, “Creating 3D Drawings.” You'll also see a Navigation
bar along the right edge of the AutoCAD window. This bar offers tools that you can use to
get around in your drawing. Basic tools like Zoom and Pan can be found here as well as some
advanced tools for viewing 3D models.

The Viewport controls in the upper-left corner of the drawing area offer menu options to
control 3D and 2D views and visual styles, and they duplicate some of the functions of the
ViewCube. You'll explore the Viewport controls when you delve into 3D modeling in Chapter 23,
“Exploring 3D Mesh and Surface Modeling.”

Just below the drawing area in the lower-left corner are the Model and Layout tabs. These
tabs enable you to switch quickly between different types of views called the model and lay-
out views. You'll get to see firsthand how these views work in a section called “Working with
AutoCAD” later in this chapter.

The Command window, located just below the drawing area, gives you feedback about the
AutoCAD commands as you use them. You can move and resize this window just as you move
and resize other display components. The Command window can be placed in a docked posi-
tion as shown in Figure 1.4 by dragging it into the status bar. We’ll elaborate on the Command
window in the section “Working in the Command Window” later in this chapter.

FIGURE 1.4

The Command window UGS icon LX Model and Layout tabs
and thestatusbar = |

4 comand: <Grid £rf>
5-

StatUS bar MODEL | {if M S

Command window
Below the Command window is the status bar (also shown in Figure 1.4). The status bar gives

you information at a glance about the state of the drawing. The tools in the status bar offer aids
to the drafting process.
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Certification
Objective

Using the Application Menu

The Application menu offers tools to help you manage your AutoCAD files. It is basically the
File pull-down menu from earlier versions of AutoCAD. Try it out to see how it works:

1. Click the Application menu icon in the upper-left corner of the AutoCAD window. A list

of options appears.

2. Move the cursor slowly down the list of options in the left column. As you highlight the
options, additional options appear in a column to the right.

3. Highlight the Export option to see the various formats available for export (see Figure 1.5).

FIGURE 1.5 [~ |
The Export option in

Search Commands

the Application menu 5=)
showing the list of
export options D L& L

e

-

L@ E D e ®

‘ Drawing
Utilities
g Close 4

Export to a different format

DWF
Create a DWF file and allow you to set
page setup overrides.

DWFx
Create a DWFx file and allow you to set
page setup overrides.

3D DWF
Create and display a DWF or DWFx file
of your 3D model in the DWF Viewer.

PDF
Create a PDF file and allow you to set
page setup overrides.

DGN
Create one or more DGN files from the
current drawing.

FBX
Create a FBX file based on the current
drawing.

Other Formats
Export the drawing to another file
format.

«

OptionsJ i Exit Autodesk AutoCAD Nautilus Beta 1

»

The Application menu also gives you a convenient way to find recently used files or to get to
a file you already have open. If you move your cursor away from the list of options to the left in
the Application menu, you'll see Recent Documents in the upper-left portion of the menu. You'll
also see two icon tools, named Open Documents and Recent Documents (see Figure 1.6).

The Open Documents option lets you quickly change from one open file to another when you
are viewing your files full-screen. The Recent Documents option displays a list of documents on

which you've recently worked.
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FIGURE 1.6
The Open Documents ‘
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You can use the View tool in the upper-right portion of the Application menu to select the
way the list of files is displayed in a manner similar to the way you would use the Windows
Explorer View option. You can click this icon and select Small Images to have the list display the
files with thumbnail images of their content. Hover over a filename and you will see a tool tip
that displays a larger thumbnail of the drawing.

Using the Ribbon

The most prominent feature in the AutoCAD window, besides the drawing area, is the Ribbon
(see Figure 1.7). This is where you’'ll be selecting tools to draw, edit, or perform other functions.
The Ribbon contains a set of panels representing groups of tools and features. The name of
each Ribbon panel is found in its title bar at the bottom of the panel. Tabs that appear above the
Ribbon panels further organize them. Each tool in the Ribbon offers a tool tip and cue card that
provides a short description to help you understand what the tool icon represents.

If you see only the Ribbon tabs, click the arrowhead button in the Ribbon Control tool. If you
don’t even see the tabs, type Ribbon...

Move the arrow cursor onto one of the Ribbon panel tools and leave it there for a moment;
you'll see a tool tip appear just below the cursor. Hold the cursor there a bit longer and the tool
tip changes to give you even more information about the tool.
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FIGURE 1.7 AR R Autodes
A typical cue card from Home| Inset Annotate Parametric View Manage |JIgSTNNRRCIN
a Ribbon panel tool e @O Ff L A

& - % I\ a- Ribbon panels

&1 Ribbon panel title bars

Polyline
Creates a 2D polyline
Tool name
A 2D polyline is a connected sequence of segments created as a
single planar object. You can create straight line segments, arc
segments, or a combination of the two.
1 2 Description/tutorial
3 4
X
6 5
= PLINE Keyboard command equivalent
Press F1 for more help Context-sensitive help

In most cases, you'll be able to guess what each tool does by looking at its icon. The icon with
an arc in the Draw Ribbon panel, for instance, indicates that the tool draws arcs; the one with
the circle shows that the tool draws circles; and so on. For further clarification, the tool tip gives
you the name of the tool.

COMMUNICATING WITH THE COMMAND WINDOW AND DYNAMIC INPUT DISPLAY

AutoCAD is the perfect servant: It does everything you tell it to do and no more. You communicate
with AutoCAD by using tools and menu options, which invoke AutoCAD commands. A command is
a single-word instruction you give to AutoCAD telling it to do something, such as draw a line (the
Line tool in the Draw Ribbon panel) or erase an object (the Erase tool in the Modify Ribbon panel).
Whenever you invoke a command, either by typing it or by selecting an option or tool, AutoCAD
responds by presenting messages to you in the Command window and the Dynamic Input display
or by displaying a dialog box. The Dynamic Input display is the display of information that appears
at the cursor and consists of messages, dimensions, and coordinates.

The messages in the Command window, or in the Dynamic Input display, often tell you what to do
next, or they may display a list of available options. A single command often presents a series of
messages that you answer to complete the command. These messages serve as an aid to new users
who need a little help. If you ever get lost while using a command or forget what you're supposed
to do, look at the Command window for clues. As you become more comfortable with AutoCAD,
you’ll find that you won’t need to refer to these messages as frequently.

You can also right-click to display a set of options that relate directly to your current activity.
For example, if you right-click before picking the first point for the Rectangle command, a set of
options appears displaying the same options that are listed in the Command prompt along with
some additional options.
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Finally, the Dynamic Input display allows you to enter dimensional data of objects as you draw
them. Besides echoing the command-line messages, the Dynamic Input display shows temporary
dimensions, coordinates, and angles of objects that you're drawing and editing. As you enter coor-
dinate or angle values through the keyboard, they appear in the Dynamic Input display. You can
easily turn the Dynamic Input display on or off by clicking the Dynamic Input tool when it is visible
in the status bar or by setting the Dynmode command to 0 for off or 3 for on. When the Dynamic
Input display is turned off, your keyboard input appears only in the Command window.

As a new user, you'll find these tool tips helpful because they show you the name of the tool
and a brief description of how to use it. Typically, when we ask you to select a tool, we'll use
the name shown in the tool tip to help you identify the tool. In the case of a tool with flyouts,
the tool name changes under different conditions. For those tools, we’ll use a general descrip-
tion to identify the tool. You'll learn more about flyouts a bit later in this chapter (see the section
“Understanding Flyouts”).

As you work through this book, we’ll ask you to select tools from the Ribbon panels. You'll
often be asked to switch between different tabs to select tools from other sets of panels. To make
the process simpler to read, we’ll use a somewhat abbreviated description of a tool’s location.
For example, for the Line tool we’ll say, “Click the Line tool in the Home tab’s Draw panel.” For
the Move tool, we’ll say, “Click the Move tool in the Home tab’s Modify panel.”

EXPANDING HIDDEN PANELS

In addition to the visible tools, some buttons are hidden from view. You can expand many of the

Ribbon panels to select more of them. If you see an arrowhead to the right of a panel’s title bar,
you can click the title bar to expand the panel (see Figure 1.8). The panel expands to reveal addi-
tional tools. If you move the cursor to the drawing area, the expanded panel shrinks to its origi-
nal size. You can also click the pushpin icon in the expanded panel title bar to lock the panel in
its open position.

FIGURE 1.8

" i N e

The arrowhead -l “

in the panel title Home Insert Annotate Parametric

bar tells you that /, B ° ; —~ - ._‘: O

additional tools are i : _ & % i\
i Line Polyline Circle Arc

available. - - ®- R @

Draw « k

= -
R YRy

Drawingl
Home Insert Annotate Parametric  Viey

) ° e O S

Click the title bar to e & % oA~
expand the panel. - R & s
Modify ~

[-1ToplI2D Wireframe]

+

Pushpin icon

11



12

CHAPTER1 EXPLORING THE INTERFACE

From now on, we'll refer to the location of additional tools as the expanded panel. For exam-
ple, we'll say, “Click the Ray tool in the expanded Draw panel” when we want you to select the
Ray tool.

If you are working on a smaller screen with low resolution, some of the Ribbon panels to the
far right may look different from what you are shown in this book. On a low-resolution screen,
AutoCAD will automatically reduce the size of the panels to the right of the Ribbon so that they
show only their title (see Figure 1.9).

FIGURE 1.9 = n - O =
The Layers, Block, ~E ';‘ Groups E I. L

Layers Block  Properties Utilities Clipboard  View

Properties, Groups,
Utilities, and View panels
are reduced to single
icons with a smaller
AutoCAD window.

To see the tools, hover over the panel (see Figure 1.10).
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Finally, the Workspace drop-down menu in the Quick Access toolbar may be hidden from
view in a low-resolution display. If you don't see these options in your AutoCAD window,
click the double arrowhead icon to the far right of the Quick Access toolbar to reveal it. If you
still don’t see the Workspace menu, click the downward-pointing arrow icon at the far-right
end of the Quick Access toolbar and select Workspace. See “Can’t Find the Tool or Panel We're
Discussing?” later in this chapter for more on “missing” interface items.

UNDERSTANDING FLYOUTS

The flyouts are one more feature that you'll want to know about. Flyouts are similar to expanded
panels because you can click an arrowhead to gain access to additional tools. Unlike a whole
panel, however, flyouts give you access to different methods for using a particular tool. For
example, AutoCAD lets you draw circles in several ways, so it offers a flyout for the Circle tool in
the Home tab’s Draw panel. If you click the arrowhead below the Circle icon in the Draw panel,
you'll see additional tools for drawing circles (see Figure 1.11).
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If you select a tool option from a flyout, that option becomes the default tool for the icon you
chose. For example, when you hover your cursor over the Circle icon in the Draw panel, the tool
tip shows “Center, Radius” for the tool’s name. If you click the arrowhead below the Center,
Radius tool and select 2-Point, then 2-Point becomes the default tool and you'll see “2-Point” for
the name of the tool in the tool tip (see Figure 1.12).

FIGURE 1.12

The tool with a flyout
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GENERAL TooL NAMES VS. TOOL TiP NAMES

Because the tool tip for tools with flyouts can change, describing them by name can be a bit prob-
lematic. The name may have changed based on the last tool you used from a flyout. For this reason,
if a tool has a flyout, we’ll refer to it by a general name that is related to the set of tools contained

continues
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continued

within it rather than by the tool tip name. For example, we’ll call the circle icon tool the Circle tool
rather than the Center, Radius tool.

Circle tool

Center, Radius

Creates a circle using a center point and a radius

TooOLS VS. THE KEYBOARD

Throughout this book, you’ll be told to select tools from the Ribbon panels to invoke commands.
For new and experienced users alike, the Ribbon panels offer an easy-to-remember method for
accessing commands. If you're an experienced AutoCAD user, you can type commands directly from
the keyboard. Most of the keyboard commands you know and love still work as they did before.

Many tools and commands have aliases. Aliases are one-, two-, or three-letter abbreviations of a
command name. As you become more proficient with AutoCAD, you may find these aliases helpful.
As you work through this book, the shortcuts will be identified for your reference.

Finally, if you're feeling adventurous, you can create your own aliases and keyboard shortcuts for
executing commands by adding them to the AutoCAD support files. Chapter 24 discusses how to
customize menus, Ribbon panels, toolbars, and keyboard shortcuts.

Picking Points in the Drawing Area

Now that you've seen the general layout of AutoCAD, take a look at the coordinate readout and
the drawing cursor to get a sense of how the parts of the AutoCAD screen work together:

1. Move the cursor around in the drawing area. As you move it, notice how the coordinate
readout changes to tell you the cursor’s location. It shows the coordinates inan X, Y, Z
format. If the coordinates are not shown on the status bar, click the customization tool at
the bottom-right corner of the AutoCAD window and click the Coordinates option check
mark. The coordinate readout will then be visible. The Customization tool looks like
three horizontal bars. See “Can’t Find the Tool or Panel We're Discussing?” later in this
chapter for more information.

2. Place the cursor in the middle of the drawing area and click the left mouse button. Move
the cursor and a rectangle follows. This is a window selection; you’ll learn more about this
window in Chapter 2. You also see a coordinate readout following the cursor and the mes-
sage Specify opposite corner or.This display at the cursor is called the Dynamic Input
display. You'll learn more about it a little later in this chapter (see Figure 1.13).

FIGURE 1.13
The Dynamic Input L)
display cursor
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3. Move the cursor a bit in any direction, and then click the left mouse button again. Notice
that the window selection disappears, as does the Dynamic Input display.

4. Try picking several more points in the drawing area. Notice that, as you click, you alter-
nately start and end a window selection. If you happen to click and drag, you will see a
lasso selection (see “Click and Drag to Lasso Objects” in Chapter 2 for more on the lasso
selection method).

If you happen to click the right mouse button, a context menu appears. A right-click fre-
quently opens a menu containing options that are context sensitive. This means the contents of
the menu depend on the location where you right-click as well as the command that is active
at the time. If there are no appropriate options at the time of the right-click, AutoCAD treats
the right-click as an Enter () keystroke. You'll learn more about these options as you progress
through the book. For now, if you happen to open this menu by accident, press the Esc key to
close it.

Using the UCS Icon

In the lower-left corner of the drawing area, you see an L-shaped line. This is the User Coordinate
System (UCS) icon, which tells you your orientation in the drawing. This icon becomes helpful
as you start to work with complex 2D drawings and 3D models. The X and Y indicate the x-

and y-axes of your drawing. Chapter 21, “Using Advanced 3D Features,” discusses this icon in
detail. For now, you can use it as a reference to tell you the direction of the axes.

Ir You CAN’T FIND THE UCS ICcON

The UCS icon can be turned on and off, so if you're on someone else’s system and you don’t see the
icon orit doesn’t look like it does in this chapter, don’t panic. See Chapter 21 for more information.

Y

L

Working in the Command Window

As mentioned earlier, at the bottom of the screen, just above the status bar, is a small horizontal
window called the Command window. Here AutoCAD displays responses to your input while
you're using a command. By default, it shows one line of text. This line shows the current
responses to your command input as well as command options. As you work through a com-
mand, you'll see more responses, with earlier responses scrolling upward in faded text. You can
view text that has scrolled out of sight by clicking the up-pointing arrowhead at the far right of
the Command window. Right now, the command line displays the words “Type a command” in
a box (see Figure 1.4, earlier in this chapter). This tells you that AutoCAD is waiting for a com-
mand. When you click a point in the drawing area, you see the message Specify opposite
corner or [Fence/WPolygon/CPolygon]:. At the same time, the cursor starts to draw a win-
dow selection that disappears when you click another point. The same message appears in the
Dynamic Input display at the cursor.
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As a new user, pay special attention to messages displayed in the Command window and
the Dynamic Input display because this is how AutoCAD communicates with you. Besides giv-
ing you messages, the Command window records your activity within AutoCAD. You can use
the scroll bar to the right of the Command window to review previous messages. You can also
enlarge the window for a better view. (Chapter 2 discusses these components in more detail.)

Now let’s look at the AutoCAD window components in detail.

THE COMMAND WINDOW AND DYNAMIC INPUT DISPLAY

The Command window and the Dynamic Input display allow AutoCAD to provide text feedback on
your actions. You can think of these features as a chat window for communicating with AutoCAD—
as you enter commands, AutoCAD responds with messages. As you become more familiar with
AutoCAD, you may find that you don’t need to rely on the Command window and Dynamic Input
display as much. For new and casual users, however, the Command window and Dynamic
Input display can be helpful in understanding what steps to take as you work.

Working with AutoCAD

Now that you've been introduced to the AutoCAD window, you're ready to try using a few
AutoCAD commands. First you'll open a sample file and make a few modifications to it. In the
process, you'll become familiar with common methods of operation in AutoCAD.

Opening an Existing File
In this exercise, you'll get a chance to see and use a typical Select File dialog box.

Before you start, make sure that you have installed the sample files for this book from the
book’s web page. See the introduction for instructions on how to find the sample files.

To start, you'll open an existing file:

1. In the Drawing tab at the top left of the drawing area, click the Close icon to the far right
of the tab.

A message appears, asking whether you want to save the changes you've made to the cur-
rent drawing. Click No.

2. In the Start tab, click the Open Files option just below the Start Drawing icon in the left
column. The Select File dialog box opens. This is a typical Windows file dialog box with
an added twist: In the large Preview box on the right, you can preview a drawing before
you open it, thereby saving time while searching for files. To the left is a panel known as
the Places list, in which you can find frequently used locations on your computer or the
Internet (see Figure 1.14).

If you don't see a Preview box in the Select File dialog box, click the word Views in the
upper-right corner and select Preview from the list that appears. Note that the Select File
dialog box can be resized if you need to view more of your drawing list.

3. In the Select File dialog box, open the Look In drop-down list and locate the Chapter 1
folder of the Mastering AutoCAD 2018 sample files. (You may need to scroll through the
list to find it.)



FIGURE 1.14
The Select File dialog
box
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4. Move the arrow cursor to the clip.dwg file and click it. Notice that the clip.dwg file-
name now appears in the File Name text box below the file list. The Preview box also now
shows a thumbnail image of the file. Be aware that a thumbnail may not show for files
from older versions of AutoCAD.

5. Click the Open button at the bottom of the Select File dialog box. AutoCAD opens the
clip.dwg file, as shown in Figure 1.15.

FIGURE 1.15
The Layoutl view of
the clip.dwg file
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Certification
Objective

The clip.dwg file opens to display a layout view of the drawing. A layout is a type of view
in which you lay out different views of your drawing in preparation for printing. You can tell
you are in a layout view by the white area over the gray background. This white area represents
your drawing on a printed page. This view is like a print preview.

Also note that the AutoCAD window’s title bar displays the name of the drawing. The name
is also displayed in the Drawing tab. This offers easy identification of the file.

This particular file contains both 2D drawings and a 3D model of a typical locking clip. The
layout view shows top, front, and right-side views as well as an isometric view.

Getting a Closer Look

One of the most frequently used commands is Zoom, which gives you a closer look at part of
your drawing. This command offers a variety of ways to control your view. In this section, you'll
enlarge a portion of the clip drawing to get a more detailed look. You use a zoom window to tell
AutoCAD which area you want to enlarge.

You'll start by switching to a Model Space view of the drawing. The Model Space view places
you in a workspace where you do most of your drawing creation and editing. Follow these steps:

1. Hover over the Clip tab at the top left of the drawing area (see the left panel in Figure 1.16).
You'll see two preview icons showing the Model Space on the left and the layout on the
right. If you hover over the Model Space image, the drawing area will temporarily change
to show you the full view of the Model Space.

2. Click the image on the left showing the Model Space (see Figure 1.16).

FIGURE 1.16

Hover over the
Drawing tab, and click
the Model Space image
(left) or click the Model
tab in the lower-left
corner of the drawing
area (right).

Modt:.l Layoutl
L3

Your view changes to show the full 3D model with the 2D representations of the model
(see Figure 1.17). You can also click the Model tab below the drawing area (see the right
panel in Figure 1.16) to accomplish the same change from the layout to Model Space.

3. Type PLAN.. Your display changes to a two-dimensional view looking down on the
drawing, as shown in Figure 1.18.
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First click here ... and then click here.

4. Click the Zoom Window tool from the Zoom flyout in the Navigation bar (see Figure 1.19).
Remember that to open the flyout, you need to click the arrowhead next to or below the tool.

FIGURE 1.19
Choosing the Zoom
Window tool from the
Zoom flyout in the
Navigation bar

Flyout arrowhead
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You can also click the Window tool from the Zoom flyout in the View tab’s Navigate
panel (see Figure 1.20) or type the command ZW.!. If you don’t see the Navigate panel,
right-click in the Ribbon and choose Show Panels > Navigate.

FIGURE 1.20
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5. The Dynamic Input display shows the Specify first corner: prompt. Look at the
image in Figure 1.18. Move the crosshair cursor to a location similar to the one shown
in the figure labeled “First click here,” and then left-click. Move the cursor, and the rect-
angle appears with one corner fixed on the point you just picked; the other corner follows

the cursor.

6. The Dynamic Input display now shows the Specify opposite corner: prompt.
Position the other corner of the zoom window so that it encloses the lower image of the
clip, as shown in Figure 1.18, and left-click the mouse again. The clip enlarges to fill the

screen.

In this exercise, you used the Window option of the Zoom command to define an area to
enlarge for your close-up view. You saw how AutoCAD prompts you to indicate first one corner
of the window selection and then the other. These messages are helpful for first-time users of
AutoCAD. You'll use the Window option frequently—not just to define views but also to select

objects for editing.

Getting a close-up view of your drawing is crucial to working accurately, but you'll often
want to return to a previous view to get the overall picture. To do so, choose Zoom Previous
from the Zoom flyout in the Navigation bar (see Figure 1.21). You may also type Z.1P..

FIGURE 1.21
The Zoom Previous
option

Zoom Extents
Zoom Window
Zoom Previous
Zoom Realtime k

Do this now and the previous view appears. Click Zoom Previous again, and the view show-

ing the entire clip returns to the screen.
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You can quickly enlarge or reduce your view by using the Zoom Realtime option of the
Zoom command. Follow these steps to change your view with Zoom Realtime:

1. Click the Zoom Realtime option from the Navigation bar’s Zoom flyout. You can also
type Z.

2. Place the Zoom Realtime cursor slightly above the center of the drawing area, and then
click and drag downward. Your view zooms out to show more of the drawing.

3. While still holding the left mouse button, move the cursor upward. Your view zooms in
and enlarges. When you have a view similar to the one shown in Figure 1.22, release the
mouse button. (Don’t worry if you don't get exactly the same view as the figure. This is
just for practice.)

@R

4. You're still in Zoom Realtime mode. Click and drag the mouse again to see how you can
further adjust your view. To exit, you can select another command besides Zoom or Pan,
or press the Esc key twice.

If you prefer, you can use the wheel on your mouse to zoom and pan over your view. Roll
the wheel to zoom in and out, or click and drag the wheel to pan. Be aware that Zoom Realtime
offers finer control over the amount of magnification than does the mouse wheel.

As you can see from this exercise, you have a wide range of options for viewing your draw-
ings just by using a few tools. These tools are all you need to control the display of 2D drawings.

Saving a File as You Work

It’s a good idea to save your file periodically as you work on it. As with any Windows program,
you can save it under its original name (click the Save tool on the Quick Access toolbar) or under
a different name (choose Save As from the Application menu or the Quick Access toolbar),
thereby creating a new file.

By default, AutoCAD automatically saves your work at 10-minute intervals under a name that
is a combination of the current filename plus a number and that ends with the .sv$ filename
extension. This is known as the Automatic Save feature. Using settings in the Options dialog box
or system variables, you can change the name of the autosaved file and control the time between
autosaves. See “The Open and Save Tab” in Appendix B for details.
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“I CAN’T FIND MY AUTOMATIC SAVES!”

As an IT manager at ELS Architecture and Urban Planning, this author (George) is often asked,
“Where does AutoCAD put the Automatic Save files?” By default, in Windows 7, Windows 8, and
Windows 10 the Automatic Save file is stored in C: \Users\User Name\appdata\local\temp\.
You can find the exact location for your system by typing Savefilepath. at the Command prompt.
This file location is often set as a hidden folder, so you may need to set up File Explorer to display
hidden folders before you can get to the Automatic Save file. You can also specify a different loca-
tion for the Automatic Save files. See Appendix B for information on how to locate hidden files and
specify a location for your files.

Making Changes

You'll frequently make changes to your drawings. One of the primary advantages of AutoCAD
is the ease with which you can make modifications. The following exercise shows you a typical
sequence of operations involved in changing a drawing:

1. Use the Save As option in the Application menu to save the current clip.dwg file under
the name MyFirst. For convenience, you can save your files in the My Documents folder.

7 2. From the Home tab’s Modify panel, click the Erase tool.

3. Notice that the cursor has turned into a small square. This square is called the pickbox.
You also see Select objects: in the Command window and the Dynamic Input display.
This message helps remind new users what to do.

4. Move the pickbox over the drawing, placing it on various parts of the clip. Don’t click
anything yet. Notice that as you hover your cursor over objects with the pickbox, they’re
dimmed and a red X appears by the cursor. This helps you see the objects that the pick-
box is likely to select and erase should you click the left mouse button.

5. Place the pickbox on the crosshatch pattern of the clip (see Figure 1.23), and click. The
crosshatch dims. The pickbox and the Select objects: prompt remain, indicating that
you can continue to select objects.

FIGURE 1.23
Erasing a portion of
the clip

Click here.

6. Press .. The crosshatch disappears. You've just erased a part of the drawing.

In this exercise, first you issued the Erase command, and then you selected an object by using
a pickbox to click it. The pickbox tells you that you must select items on the screen, and it shows
you what you're about to select by highlighting objects as you hover the cursor over them. Once
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you've clicked an object or a set of objects, press ! to move on to the next step. This sequence of
steps is common to many of the commands you’ll work with in AutoCAD.
You can also click an object or a set of objects and then press the Delete key.

Working with Multiple Files

You can have multiple documents open at the same time in AutoCAD. This feature can be espe-

cially helpful if you want to exchange parts of drawings between files or if you want another file
open for reference. Try the following exercise to see how multiple documents work in AutoCAD:

1. In the Start tab, locate the Templates option at the bottom of the Start Drawing icon and
click it (see Figure 1.24).

FIGURE 1.24 Get Started
Click the Templates
option below the Start ]
. . Y [
D . J
rawing icon _@ iy

Start Drawing

H emplates v

2. Select acad.dwt from the drop-down list.

3. Go to the Ribbon and, in the View tab’s Interface panel, click Tile Vertically to get a view
of both drawing files and the Start tab.

4. Click the minimize button in the upper-right corner of the Start tab window, and then
click Tile Vertically in the Interface panel again to get a better view of the two drawings.

When you create a new file in AutoCAD, you're actually opening a copy of a template file, as
you saw in step 1. A template file is a blank file that is set up for specific drawing types. The
acad.dwt file is a generic template set up for Imperial measurements. Another template file,
called acadiso.dwt, is a generic template useful for metric measurements. Other templates are
set up for specific drawing-sheet sizes and measurement systems. You'll learn more about tem-
plates in Chapter 6, “Editing and Reusing Data to Work Efficiently.”

Next let’s try drawing a rectangle to see how AutoCAD behaves while drawing objects:

1. Making sure that you have the newly created drawing as the active window, click the
Rectangle tool in the Home tab’s Draw panel, as shown in Figure 1.25.

FIGURE 1.25
Click the Rectangle
tool in the Draw panel.

Notice that the Command window now shows the following prompt:

Specify first corner point or
[Chamfer/Elevation/Fillet/Thickness/Width]:
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AutoCAD is asking you to select the first corner for the rectangle, and in brackets, it’s
offering a few options of which you can take advantage at this point in the command.
Don’t worry about those options right now. You'll have an opportunity to learn about
command options in Chapter 2. You also see the same prompt, minus the bracketed
options, in the Dynamic Input display at the cursor. You can view the command options
at the cursor by pressing the down arrow key on your keyboard.

. Click a point roughly in the lower-left corner of the drawing area, as shown in Figure 1.26.

Now as you move your mouse, a rectangle follows the cursor, with one corner fixed at the
position you just selected. You also see the following prompt in the Command window,
with a similar prompt in the Dynamic Input display:

Specify other corner point or [Area/Dimensions/Rotation]:

FIGURE 1.26 Click here to start the rectangle.
Selecting the first point
of a rectangle
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3. Click another point anywhere in the upper-right region of the drawing area, but avoid

getting too close to the ViewCube (see Figure 1.27). A rectangle appears. If you happen
to accidentally open the ViewCube context menu, press Escape once and you will be able
to position the corner. You'll learn more about the different cursor shapes and what they
mean in Chapter 2.
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4. Let’s try copying objects between these two files. Click in the window with the clip draw-
ing to make it active.

5. Click Zoom All from the Zoom flyout of the Navigation bar to get an overall view of the
drawing (see Figure 1.28). You can also type ZJA ..

FIGURE 1.28

The Zoom All option
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view of your drawing.
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6. Click the 2D version of the clip at the bottom of the drawing to select it. A dot appears
at the center of the clip, and a rectangle encloses it. You may find that some parts of the
drawing within the rectangle have not been highlighted. If this happens, just click them
in addition to the main clip drawing. The dot is called a grip; you'll learn more about
grips in the next chapter (see Figure 1.29).

FIGURE 1.29 e — =
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Select this part
of the drawing.

7. Right-click, select Clipboard, and then select Copy. You can also press Ctrl+C to invoke
the Windows Copy To Clipboard shortcut.

8. Click inside the other drawing window to make it active.

9. Right-click, select Clipboard, and then select Paste. You can also press Ctrl+V to invoke
the Windows Paste From Clipboard shortcut. The Specify Insertion Point prompt
appears.
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10. Click inside the rectangle. The clip appears at the cursor in the new drawing.

11. This ends the exercises for this chapter. Save your myfirst.dwg file for future reference.
You can close the new drawing without saving it. You may have to maximize the Start
tab, which will still be minimized at the bottom of the screen.

LOSE THE NAVIGATION BAR?

If for some reason the Navigation bar is not visible, you can find it on the View tab’s Viewport Tools
panel. Click the Navigation Bar tool. The tool will highlight in blue and the Navigation bar will
appear. You can also type Navbar.! at the command line and choose one of the two options (On/
Off). This panel also shows the tool to display the UCS icon and ViewCube if they also get misplaced.

Note that you've had two files open at once. You can have as many files open as you want as
long as your computer has adequate memory to accommodate them. You can control the indi-
vidual document windows as you would any window, using the window control buttons in the
upper-right corner of the drawing area.

Adding a Predrawn Symbol with the Tool Palettes

In the preceding exercise, you saw how you could easily copy an object from one file to another
by using the standard Windows Cut and Paste feature. AutoCAD offers several tool palettes that
enable you to click and drag predrawn objects into your drawing.

You can open the tool palettes by clicking the Tool Palettes tool in the View tab’s Palettes panel,
as shown in Figure 1.30.

FIGURE 1.30 View tab
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Once the tool palettes are open, you can select a tab containing the predrawn objects you
want to use and then click the specific object you want to add. The object appears at the cursor,
ready for you to select a location (see Figure 1.31).

In addition to predrawn objects, the tool palettes offer a way to add hatch patterns and other
components quickly to your drawing. They're great tools to help you manage your library of
custom, predrawn symbols. Chapter 25, “Managing and Sharing Your Drawings,” shows you
how to use and customize the tool palettes.
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FIGURE 1.31 Select a tab containing predrawn

The tool palettes offer symbols you want to use. Click on a symbol.
predrawn symbols that
you can easily place in
your drawings.
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The symbol appears at the cursor ready to be placed in the drawing.

CAN’T FIND THE TOOL OR PANEL WE’RE DISCUSSING?

The AutoCAD interface is easy to customize, and sometimes tools and options are hidden from view
due to changes other users have made or as a result of changes from our review software to the
final release version. If you don’t see a tool or icon we're asking you to use in this or other chapters,
here are a few places to check.

Quick Access Toolbar If you don’t see an icon in the Quick Access toolbar, you can click
the Customize Quick Access Toolbar tool at the right end of the toolbar to open a list of addi-
tional Quick Access toolbar options.

Customize Quick Access Toolbar

Options that already appear in the toolbar show a check mark next to their name in the menu.
Click the option that you want to have visible in the toolbar to make it visible. Clicking on an
option that shows a check mark will hide that option from the toolbar.

Status Bar Items missing from the status bar can be found by clicking the Customization
tool in the lower-right corner of the AutoCAD window.

|

Customization

ALl @& v 4| &

continues
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continued

See

This opens a menu of tools that can be added to the status bar. Just as with the Quick Access
toolbar, items that already appear in the status bar will display a check mark in the menu next
to their name. If you need to check and uncheck multiple options, you can turn on the Lock UI
option in the list. Lock UI keeps the menu open after you make a selection.

Ribbon If a Ribbon panel or Ribbon tab is missing, you can right-click in the Ribbon panel
to open a menu that offers a list of available panels and tabs.

Add to Quick Access Toolbar
Show Tabs

Show Panels

If you select the Show Tabs option, you will see a list of all of the tabs that are available for the
current workspace. If you select the Show Panels option, you will see a list of panels that are
available for the current Ribbon tab.

USC Icon, ViewCube, and Navigation Bar Some of the more useful panels in the
AutoCAD interface can be turned on and off through tools in the Ribbon. The UCS icon,
ViewCube, and Navigation bar can be controlled through tools in the View tab’s Viewport
Tools panel.

—————— Onthe View Tab
mE NN

UCS  View Navigation
Ion Cube  Bar

Viewport Tools ~

Reset AutoCAD to the Default Settings Finally, if your version of AutoCAD looks com-
pletely different from what you see here, you can reset your AutoCAD profile to the default
settings.

1. Typeoptions..

2. Inthe Options dialog box, select the Profiles tab at the upper right.
3. Click the Reset button in the right-hand column.

4. Click OK to exit the Options dialog box.

“The Profiles Tab” in Appendix B for more information on how to save and restore the way

AutoCAD is set up. Note that AutoCAD LT 2018 does not have a Profiles tab.

The

Bottom Line

Use the AutoCAD® window. AutoCAD® is a typical Windows graphics program that
makes use of menus, toolbars, Ribbon panels, and palettes. If you've used other graphics
programs, you'll see at least a few familiar tools.

Master It Name the components of the AutoCAD window that you can use to select a
function.



THE BOTTOM LINE

Get a closer look with the Zoom command. One of the first things that you'll want to
learn is how to manipulate your views. The Zoom command is a common tool in graphics
programs.

Master It Name at least two ways of zooming into a view.

Save a file as you work. Nothing is more frustrating than having a power failure that
causes you to lose hours of work. It’s a good idea to save your work frequently. AutoCAD
offers an Automatic Save feature that can be a lifesaver if you happen to forget to save your
files.

Master It How often does the AutoCAD Automatic Save feature save your drawing?

Make changes and open multiple files. As with other Windows programs, you can have
multiple files open and exchange data between them.

Master It With two drawings open, how can you copy parts of one drawing into the
other?
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Creating Your First Drawing

This chapter examines some of the basic functions of the AutoCAD® software. You'll get a
chance to practice with the drawing editor by building a simple drawing to use in later exer-
cises. You'll learn how to give input to AutoCAD, interpret prompts, and get help when you
need it. This chapter also covers the use of coordinate systems to give AutoCAD exact measure-
ments for objects. You'll see how to select objects that you've drawn and how to specify base
points for moving and copying.

If you're not a beginning AutoCAD user, you may want to move on to the more complex
material in Chapter 3, “Setting Up and Using the Drafting Tools.” You can use the files supplied
at the book’s web page (www.sybex.com/go/masteringautocad2018) to continue the tutorials at
that point.

Beginning in this chapter, we’ll be using a setup that displays a white drawing background
instead of the dark gray background you see on your screen. We do this to keep the figures leg-
ible in the printed version of this book, but the difference should not hinder your understand-
ing of the figures. If you like, you can set up your screen with a white background by following
the instructions in Appendix B, “Installing and Setting Up AutoCAD,” in the section “Set Up
AutoCAD with a White Background.”

In this chapter, you will learn to

Specify distances with coordinates

Interpret the cursor modes and understand prompts
Select objects and edit with grips

Use dynamic input

Display data in a text window

Display the properties of an object

Gethelp

® & ¢ ¢ o o o

Getting to Know the Home Tab’s Draw
and Modify Panels

Your first task in learning how to draw in AutoCAD software is simply to draw a line. Since
AutoCAD is designed as a precision drawing tool, you'll be introduced to methods that allow
you to input exact distances. But before you begin drawing, take a moment to familiarize
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yourself with the features that you'll be using more than any other to create objects with
AutoCAD: the Draw and Modify panels. Try these steps:

1. Start AutoCAD just as you did in Chapter 1, “Exploring the Interface,” by choosing Start
> All Programs > Autodesk > AutoCAD 2018 > AutoCAD 2018.

2. Click the Templates drop-down arrowhead in the Dashboard and select acad.dwt
(see Figure 2.1). Metric users should use the acadiso.dwt template. You could also click
the Start Drawing icon, but we ask you to use the acad.dwt or acadiso.dwt template to
ensure that you are set up with the same defaults as in this exercise.

FIGURE 2.1
The Templates
drop-down list
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3. Make sure that you are in the Drafting & Annotation workspace. Click the Workspace
Switching tool in the status bar, and select Drafting & Annotation.

v Drafting & Annotation
3D Basics
3D Modeling

Save Current As...

Workspace Settings...

Customize...

Display Workspace Label

kR A8 +]P[C

0

Workspace Switching tool.
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4. Move the arrow cursor to the Line tool in the Home tab’s Draw panel at the far upper-left
portion of the AutoCAD window, and rest it there so that the tool tip appears. As you
hold the cursor over the tool, first one tool tip appears and then another (see Figure 2.2).
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5. Slowly move the arrow cursor to the right over the other tools in the Home tab’s Draw
panel, and read each tool tip.

In most cases, you'll be able to guess what each tool does by looking at its icon. The icon with
an arc, for instance, indicates that the tool draws arcs; the one with the ellipse signifies that the
tool draws ellipses; and so on. If you hover over the tool, you'll see the tool tip name and the
keyboard command associated with the tool. Hold the cursor for a bit longer, and a cue card
appears that gives a brief explanation of how to use the tool.

DON’T GET STUCK ON THE PROMPTS

In many of the exercises in this book, we’ll mention the Command prompt that appears in the
Command window. The prompts are shown for your reference, but don’t let yourself get too bogged
down by them. For example, we’ll say, “At the Specify lower left corner or [ON/OFF]
<0.0000,0.0000>: prompt, press .l.” The important part is to press ). You can skim over the
prompt. Just keep in mind that the prompts can offer some direction and show the options for the
current command. They can also serve as helpful reminders later when you're working on your own.

You see several tools in the Home tab’s Draw and Modify panels. In Chapter 1, you saw
that if you click the arrow in a panel’s title bar, the panel expands to reveal more tools
(see Figure 2.3). Once you've selected a tool from the expanded Draw or Modify panel, the
expanded panel closes. If you want to keep the expanded panel open, click the pushpin icon
at the left end of the expanded panel’s title bar.
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Starting Your First Drawing

In Chapter 1, you looked at a preexisting sample drawing. This time, you'll begin to draw your
own drawing by creating a door that will be used in later exercises. First, though, you must
learn how to tell AutoCAD what you want, and, even more important, you must understand
what AutoCAD wants from you.

IMPERIAL AND METRIC

In this chapter, you’ll start to see instructions for both Imperial and metric measurements. In
general, you'll see the instructions for Imperial measurement first, followed by the metric instruc-
tions. You won't be dealing with inches or centimeters yet, however. You're just getting to know
the AutoCAD system.

You'll start by setting the size of the work area, known as the drawing limits. These limits
aren't fixed in any way, and you aren’t forced to stay within the bounds of the drawing limits
unless the Limits command’s ON/OFF option is turned on. But limits can help to establish a
starting area from which you can expand your drawing.

You currently have a new blank file, but it’s a little difficult to tell the size of your drawing
area. Let’s set up the work area so that you have a better idea of the space with which you're
working;:

1. Enter Limits..
2. Atthe Specify lower left corner or [ON/OFF] <0.0000,0.0000>: prompt, press ...

3. Atthe Specify upper right corner <12.0000,9.0000>: prompt, press .| to accept the
default of 12.0000,9.0000. Metric users should enter 40,30..
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Certification 4. Type Z. A for the Zoom All command. You can also select Zoom All from the Zoom
ORgFtive flyout on the Navigation bar.

5. Metric users do the following: Open the Application menu and choose Drawing Utilities >
Units or enter Units.. In the Units dialog box, select Centimeters from the Insertion Scale
panel’s drop-down list and click OK. See “Inserted Drawings Not to Scale?” in Chapter 25,
“Managing and Sharing Your Drawings,” for more on the Insertion Scale setting.

In step 4, the All option of the Zoom command uses the limits you set up in steps 2 and 3 to
determine the display area. In a drawing that contains objects, the Zoom tool’s All option dis-
plays the limits plus the area occupied by the objects in the drawing if they happen to fall out-
side the limits. Now give your file a unique name:

Certificdon 1. Choose Save As from the Application menu or type Saveas.! to open the Save Drawing
Objective As dialog box.

2. Type Door. As you type, the name appears in the File Name text box.

3. Save your file in the My Documents folder or, if you prefer, save it in another folder of your
choosing. Just remember where you put it because you’'ll use it later.

4. Click Save. You now have a file called Door .dwg, located in the My Documents folder. Of
course, your drawing doesn’t contain anything yet. You'll take care of that next.

UNDERSTANDING THE DRAWING AREA

The new file shows a drawing area roughly 12 inches wide by 9 inches high. Metric users have a file
that shows an area roughly 40 centimeters (cm) wide by 30 cm high. This is just the area you're given
to start with, but you're not limited to it in any way. No visual clues indicate the size of the area. To
check the area size for yourself, move the crosshair cursor to the upper-right corner of the draw-
ing area and observe the value in the coordinate readout in the lower-left corner. The coordinate
readout won’t show exactly 12’9 inches, or 40’30 cm for metric, because the proportions of your
drawing area aren’t likely to be exactly 129 or 40”30. AutoCAD does try to optimize the display
for the drawing area when you choose the All option of the Zoom command.

Now you can start to explore the drawing process. To begin a drawing, follow these steps:
1. Click the Line tool on the Home tab’s Draw panel, or type L.

You've just issued the Line command. AutoCAD responds in two ways. First, you see the
message

Specify first point:

in the Command prompt, asking you to select a point to begin your line. Also, the cursor
changes its appearance; it no longer has a square in the crosshairs. This is a clue telling
you to pick a point to start a line.

2. Using the left mouse button, select a point on the screen just a little to the left and below
the center of the drawing area (see Figure 2.4). After you select the point, AutoCAD
changes the prompt to this:

Specify next point or [Undo]:
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Now, as you move the mouse around, notice the line with one end fixed on the point you just
selected and the other end following the cursor in a rubber-banding motion (see the first image
in Figure 2.4). You also see a message at the cursor asking you to Specify next point or.

3. Move the cursor to a location directly to the left or right of the point you clicked, and
you’ll see a dashed horizontal line appear along with a different message at the cursor.
This action also occurs when you point directly up or down. Your cursor seems to jump
to a horizontal or vertical position.

This feature is called Polar Tracking. Like a T square or triangle, it helps restrict your line to
an exact horizontal or vertical direction. You can turn Polar Tracking on or off by clicking
the Polar Tracking tool in the status bar. You'll learn more about this tool in Chapter 3.
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4. Continue with the Line command. Move the cursor to a point below and to the right of
the first point you selected and click again. You've just drawn a line segment, and a sec-
ond rubber-banding line appears (see the second image in Figure 2.4).

5. If the line you drew isn’t the exact length you want, you can back up during the Line
command and change it. To do this, type U. The line you drew previously rubber-bands
as if you hadn’t selected the second point to fix its length.

6. Right-click and select Enter. This terminates the Line command.

The Undo and Redo tools in the Quick Access toolbar offer Undo and Redo drop-down
lists from which you can select the exact command you want to undo or redo. See the sidebar
“Getting Out of Trouble” later in this chapter for more information.

You've just drawn, and then undrawn, a line of an arbitrary length. In step 6 of the previous
exercise, you were asked to terminate the Line command. If you happen to forget that a com-
mand is still active, two onscreen clues can remind you of the status of AutoCAD. If you don't
see the words Type a Command in the Command window, a command is still active. Also, the
cursor is the plain crosshair without the box at its intersection.

Many tools will display a small icon or badge next to the cursor. The badge will be similar to
the tool’s icon in most cases. A red X appears when you hover over an object while using the
Erase tool. A question mark appears when you use the Measure, ID, or List tool.

From now on, we'll refer to the crosshair cursor without the small box as the Point Selection
mode of the cursor. Figure 2.5 shows all the modes of the drawing cursor.
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WHY USE THE KEYBOARD COMMANDS?

For many years, Autodesk has been encouraging users to move away from the command line and
keyboard method of command entry, but it seems that AutoCAD users will have none of that.
Although you would expect “grizzled veteran” users to stick with the keyboard entry method, you
might be surprised to find that young, “fresh out of school” apprentice architects also prefer the
keyboard over the newer palettes and ribbons in AutoCAD.

We made this observation to one of the designers of AutoCAD at a recent Autodesk function.
Without hesitation, he answered that “keyboard entry is much faster.” In our experience, it isn’t just
faster. Entering commands via the keyboard gives you a more “connected” feeling with AutoCAD.
Work seems to flow much smoother. If you learn the keyboard commands, you’ll also find that cus-
tomizing AutoCAD is much easier. So for these reasons, we encourage you to try both the keyboard
and the buttons to see which you prefer. You'll find that, wherever possible, we’ll give the keyboard
command equivalent to a tool selection in the exercises of this book. Remember that a tool’s tool
tip will also show its keyboard command.

Specifying Exact Distances with Coordinates

Certification  Next, you'll continue with the Line command to draw a plan view (an overhead view) of a door,
Objective to no particular scale. This will give you some practice in drawing objects to exact distances.
Later, you'll resize the drawing for use in future exercises. The door will be 3 units long and
0.15 units thick. For metric users, the door will be 9 units long and 0.5 units thick. To specify
these exact distances in AutoCAD, you can use either relative polar coordinates or Cartesian
coordinates.

GETTING OUT OF TROUBLE

Beginners and experts alike are bound to make a few mistakes. Before you get too far into the
exercise, here are some powerful but easy-to-use tools to help you recover from accidents:

Backspace If youmake a typing error, press the Backspace key to back up to your error
and then retype your command or response. The Backspace key is in the upper-right corner
of the main keyboard area.

Escape (Esc) This is perhaps the single most important key on your keyboard. When you
need to exit a command or a dialog box quickly without making changes, press the Esc key
in the upper-left corner of your keyboard. In most cases, you need to press Esc only once,

although it won’t hurt to press it twice. (Press Esc before editing with grips or issuing com-

mands through the keyboard.)

U If you accidentally change something in the drawing and want to reverse that change,
click the Undo tool in the Quick Access toolbar (the left-pointing curved arrow). You can
also type UJ at the Command prompt. Each time you do this, AutoCAD undoes one opera-
tion at a time, in reverse order. The last command performed is undone first, then the
next-to-last command, and so on. The prompt displays the name of the command being
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undone, and the drawing reverts to its state prior to that command being issued. If you
need to, you can undo everything back to the beginning of an editing session. You can also
select the exact command to back up to by using the Undo drop-down list in the Quick
Access toolbar.

Textscr
Textscr

Intellipan

Rotate

Rectang

You can open the Undo drop-down list by clicking the down-pointing arrow found to the right
of the Undo tool.

Undo If you want more control over the way Undo works, you can use the Undo command.
This command allows you to “bookmark” places to which you can “undo” in your editing
session. Type Undo.l, and you'll see the Enter the number of operations to undo

or [Auto/Control/BEgin/End/Mark/Back] <1>: prompt. Enter a number indicat-

ing the number of steps you want to undo. Use the Mark option to bookmark a location;

then use Back to undo your work to that bookmark. You can use Begin and End to mark the
beginning and ending of a set of operations that will be undone all at once. Control offers
options to control the behavior of the Undo command. Auto is an option that is on by default
and causes AutoCAD to undo the action of the whole command rather than the individual
actions within a command.

Redo If you accidentally undo one too many commands, you can redo the last undone
command by clicking the Redo tool (the right-pointing curved arrow) in the Quick Access
toolbar, or you can type Redo.l. You can redo several operations that you may have undone
with the Undo command. You can also select the exact command to redo by using the Redo
drop-down list in the Quick Access toolbar.

/ =~ Quick properties
N Quick properties
Grip edit

Line Polyliy

Copy

Oops If you've deleted something and gone on to use other commands, you can restore the
last deleted object or objects by using the Oops command. Oops enables you to restore the last
deleted set of objects without having to undo a series of commands.

The Imperial and metric distances aren’t equivalent in the exercises in this chapter. For
example, 3 units in the Imperial-based drawing aren’t equal to 9 metric units. These distances
are arbitrary and based on how they appear in the figures in this chapter.
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Specifying Polar Coordinates

Certification 10 enter the exact distance of 3 (or 9 metric) units to the right of the last point you selected, do
Objective the following:

1. Click the Line tool on the Home tab’s Draw panel, or type L.
2. Click a point slightly to the left of the center of the drawing area to select the start point.

3. Type @3<0. Metric users should type @9<0. As you type, the letters appear at the
Command prompt.

4. Press . A line appears, starting from the first point you picked and ending 3 units to the
right of it (see Figure 2.6). You've just entered a relative polar coordinate.
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The “at” sign (@) you entered tells AutoCAD that the coordinate you're specifying is from
the last point you selected. The 3 (or 9, metric) is the distance, and the less-than symbol (<) tells
AutoCAD that you're designating the angle at which the line is to be drawn. The last part is the
value for the angle, which in this case is 0 for 0°. This is how to use polar coordinates to commu-
nicate distances and directions to AutoCAD.

If you're accustomed to a different method for describing directions, you can set AutoCAD to
use a vertical direction as 0°. See Chapter 3 for details.

Angles are given based on the system shown in Figure 2.7, in which 0° is a horizontal direc-
tion from left to right, 90° is straight up, 180° is horizontal from right to left, and so on. You can
specify degrees, minutes, and seconds of arc if you want to be that exact. You can also specify
angles using negative values, which would mirror the direction around the x-axis. For example,
a minus 45° angle would point in the direction shown as 315° in Figure 2.7. We'll discuss angle
formats in more detail in Chapter 3.
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Specifying Relative Cartesian Coordinates

Certification For the next line segment, let’s try another method for specifying exact distances:
Objective
1. Enter @0,0.15. Metric users should enter @0,0.5... A short line appears above the end-

point of the last line. Once again, @ tells AutoCAD that the coordinate you specify is from
the last point picked. But in this example, you give the distance in X and Y values. The X
distance, 0, is given first, followed by a comma, and then the Y distance, 0.15 or 0.5. This is
how to specify distances in relative Cartesian coordinates.

COMMAS AND PERIODS

Step 1 indicates that metric users should enter @0,0.5.! for the distance. Instead, you could enter
@0,.5 (zero comma point five). The leading zero is included for clarity. European metric users
should be aware that the comma is used as a separator between the X and Y components of the
coordinate. In AutoCAD, commas aren’t used for decimal points; you must use a period to denote
a decimal point.

2. Enter @-3,0.J. Metric users should enter @-9,0.J. This distance is also in XY values, but
here you use a negative value to specify the X distance. The result is a drawing that looks
like Figure 2.8.

Positive values in the Cartesian coordinate system are from left to right and from bottom
to top (see Figure 2.9). (You may remember this from your high school geometry class!) If
you want to draw a line from right to left, you must designate a negative value. It’s also
helpful to know where the origin of the drawing lies. In a new drawing, the origin—or
coordinate 0,0—is in the lower-left corner of the drawing.
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3. Type C. This C stands for the Close option. You can also click the Close option in the
command line or right-click and select Close from the context menu. A line connecting
the first and last points of a sequence of lines is drawn (see Figure 2.10), and the Line com-
mand terminates. The rubber-banding line also disappears, telling you that AutoCAD
has finished drawing line segments. You can also use the rubber-banding line to indicate
direction while simultaneously entering the distance through the keyboard. See the side-
bar “Other Ways to Enter Distances” later in this chapter.



INTERPRETING THE CURSOR MODES AND UNDERSTANDING PROMPTS

FIGURE 2.10 @-3,0
Distance and direc- =
tion input for the door. [@90]
Distances for metric
15
users are shown in Close l [ T [@égo .
brackets. ,0.
@3<0
[@9<0]

To finish drawing a series of lines without closing them, you can press Esc, ., or the spacebar.

Interpreting the Cursor Modes and Understanding
Prompts

The key to working with AutoCAD successfully is understanding the way it interacts with you.
The following sections will help you become familiar with some of the ways AutoCAD prompts
you for input. Understanding the format of the messages in the Command window and recog-
nizing other events on the screen will help you learn the program more easily.

Understanding Cursor Modes

As the Command window aids you with messages, the cursor gives you clues about what to do.
Earlier in this chapter, Figure 2.5 illustrates the various modes of the cursor, and it gives a brief
description of the role of each mode. Take a moment to study this figure.

Standard Cursor The Standard cursor tells you that AutoCAD is waiting for instructions.
You can also edit objects by using grips when you see this cursor. Grips are squares, rect-
angles, or arrowheads that appear at endpoints and at the midpoint of objects when they’re
selected. (You might know them as workpoints from other graphics programs.)

Point Selection Cursor The Point Selection cursor appears whenever AutoCAD expects
point input. It can also appear in conjunction with a rubber-banding line. You can either click
a point or enter a coordinate through the keyboard.

Cursor with Badge The Cursor with Badge lets you know at a glance which tool you are
using. The badge will be similar to the tool icon currently being used. A red X badge appears
when you hover over an object while using the Erase tool. A question mark badge appears
when you use the Measure, ID, or List tool.

Object Selection or Pickbox Cursor The Object Selection or Pickbox cursor tells you that
you must select objects—either by clicking them or by using any of the object-selection
options available.

Osnap (Object Snap) Marker The osnap (object snap) marker appears along with the Point
Selection cursor when you invoke an osnap. Osnaps let you accurately select specific points
on an object, such as endpoints or midpoints.

Tracking Vector The tracking vector appears when you use the Polar Tracking or Object
Snap Tracking feature. Polar Tracking aids you in drawing orthogonal lines, and Object Snap
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Tracking helps you align a point in space relative to the geometry of existing objects. Object
Snap Tracking works in conjunction with osnaps. You'll learn more about the tracking vector
in Chapter 3.

Certification If you're an experienced AutoCAD user, you may prefer to use the old-style crosshair cursor
Objective  that crosses the entire screen. Choose Options from the bottom of the Application menu to open
the Options dialog box, and then click the Display tab. Set the Crosshair Size option near the
bottom right of the dialog box to 100. The cursor then appears as it did in previous versions of
AutoCAD. As the option name implies, you can set the crosshair size to any percentage of the
screen you want. The default is 5 percent.

OTHER WAYS TO ENTER DISTANCES

Certification A third method for entering distances is to point in a direction with a rubber-banding line and
Objective then enter the distance through the keyboard. For example, to draw a line 3 units long from left to
right, click the Line tool on the Home tab’s Draw panel, click a start point, and then move the cur-
sor so that the rubber-banding line points to the right at some arbitrary distance. With the cursor
pointing in the direction you want, type 3. The rubber-banding line becomes a fixed line 3 units
long. Using this method, called the Direct Distance method, along with the Ortho mode or Polar

Tracking (described in Chapter 3), can be a fast way to draw orthogonal lines of specific lengths.

You can also specify an exact angle along with the distance. For example, start the Line command
and then pick the first point. Type 3 for the length, but don’t press . Press the Tab key instead.
The line segment will become fixed at 3 units, and as you move the cursor, the segment will rotate
freely around the first point. Next, type an angle in degrees, 30 for example, and the line will
be drawn at 30 degrees. Or, instead of typing in an angle, just adjust the angle of the line visually
until you see the angle you want on the Dynamic Input temporary angle dimension and then click.

Start a line, then type 3 and press the Tab key.

The 3 appears in the temporary dimension,

and as you move the cursor, the line

rotates about the first point.

Type an angle value.
As you do, the value
appears in the
temporary angle
dimension. Press .
to finish the line.

If you watch the temporary dimensions as you press the Tab key, you'll see that the Tab key lets you
move from the length dimension to the angle dimension and back again. You can press the Tab key
at any time to shift back and forth between dimensions. A lock appears next to a dimension that
you have entered, telling you that the dimension is “locked” until you tab to it again.

You'll learn more about how to enter values with Dynamic Input’s temporary dimensions later in
this chapter.
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Choosing Command Options

Many commands in AutoCAD offer several options, which are often presented to you in the
Command window in the form of a prompt. This section uses the Arc command to illustrate the
format of AutoCAD prompts.

Usually, in a floor plan drawing in the United States, an arc is drawn to indicate the direction
of a door swing. Figure 2.11 shows other standard symbols used in architectural-style drawings.
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Next, you'll draw the arc for the door you started in the previous exercise:

1. Click the 3-Point Arc tool in the Home tab’s Draw panel. Click the Arc flyout and select
3-Point. The Specify start point of arc or [Center]: promptappears in the
Command window, and the cursor changes to Point Selection mode. You also see the
prompt Specify start point of arc or prompt next to the cursor.

Examine the Specify start point of arc or [Center]: prompt. The prompt con-
tains two options. The default is stated in the main part of the prompt, which is to specify
the start point of the arc. If other options are available, they appear within square brack-
ets. In the Arc command, you see the word Center within brackets telling you that, if
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you prefer, you can also start your arc by selecting a center point instead of a start point.
If multiple options are available, they appear within the brackets and are set off with a

slightly darker background. This background tells you that the option is selectable using
your cursor and also aids in separating option names. The default is the option AutoCAD
assumes you intend to use unless you tell it otherwise.

2. Type Cd to select the Center option or click the word Center in the command line. The

Specify center point of arc: prompt appears. Notice that you had to type only the C
and not the entire word Center.

When you see a set of options in the Command window, note their capitalization. If you
choose to respond to prompts by using the keyboard, these capitalized letters are all you
need to enter to select the option. In some cases, the first two letters are capitalized to dif-
ferentiate two options that begin with the same letter, such as LAyer and LType. You can
also just click the option name in the Command prompt to select the option.

3. Pick a point representing the center of the arc near the upper-left corner of the door (see

Figure 2.12). The Specify start point of arc: promptappears.

4. Type @3<0.. Metric users should type @9<0.1. The Specify end point of arc (hold

Ctrl to switch direction) or [Angle chord Length]: prompt appears.

5. Move the mouse and a temporary arc appears, originating from a point 3 units to
the right of the center point you selected and rotating about that center, as shown in
Figure 2.12. (Metric users will see the temporary arc originating 9 units to the right
of the center point.)

As the prompt indicates, you now have three options. You can enter an angle, a chord
length, or the endpoint of the arc. The prompt default, to specify the endpoint of the

arc, picks the arc’s endpoint. Again, the cursor is in Point Selection mode, telling you it’s
waiting for point input. To select this default option, you only need to pick a point on the
screen indicating where you want the endpoint.

6. Move the cursor so that it points in a vertical direction from the center of the arc. You'll

see the Polar Tracking vector snap to a vertical position.

7. Click any location with the Polar Tracking vector in the vertical position. The arc is now
fixed in place, as shown in Figure 2.12.
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This exercise has given you some practice working with AutoCAD Command window
prompts and entering keyboard commands—skills you'll need when you start to use advanced

AutoCAD functions.
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Certification
Objective

As you can see, AutoCAD has a distinct structure in its prompt messages. You first issue a
command, which in turn offers options in the form of a prompt. Depending on the option you
select, you get another set of options or you're prompted to take some action, such as picking a
point, selecting objects, or entering a value.

As you work through the exercises, you'll become intimately familiar with this routine. After
you understand the workings of the Ribbon panels, the Command window prompts, and the
dialog boxes, you can almost teach yourself the rest of the program!

USING AUTOCOMPLETE AND AUTOCORRECT

You may have noticed that as you enter a command through the keyboard, the Command window
offers suggestions to complete your typing in a way similar to many web browsers. For example,
if you type LI, a list pops up offering a number of commands that start with LI. You can then
click the option that you want to use. This feature can be helpful when you forget the full name
of a command.

AutoCorrect works in a similar way, but instead of offering a list of commands that start with the
letters you type, AutoCAD will try to “correct” a mistyped command. For example, if you type crl,
AutoCAD will display several commands that come close to what you typed.

You can also control how the AutoComplete and AutoCorrect features work. Right-click in the
Command window, and then point to the Input Settings option that appears in the context menu.
You can then toggle several options on or off. The options are AutoComplete, AutoCorrect, Search
System Variables, Search Content, Mid-string Search, and Delay Time.

SELECTING OPTIONS FROM A CONTEXT MENU

Now you know that you can select command options by typing them. You can also right-click
at any time during a command to open a context menu containing those same options. For
example, in step 2 in the previous exercise, you typed C to tell AutoCAD that you wanted to
select the center of the arc. Instead of typing, you can also right-click to open a menu of options
applicable to the Arc command at that time.

In addition to the options shown in the Command prompt, the context menu shows you a
few more: Enter, Cancel, Pan, and Zoom. The Enter option is the same as pressing ... Cancel can-
cels the current command. Pan and Zoom let you adjust your view as you're working through
the current command.

The menu is context sensitive, so you see only those options that pertain to the command or
activity that is currently in progress. Also, when AutoCAD is expecting a point, an object selec-
tion, or a numeric value, right-clicking doesn’t display a context menu. Instead, AutoCAD treats
a right-click as .

The location of your cursor when you right-click determines the contents of the list of avail-
able operations. A right-click in the Command window displays a list of operations that you can
apply to the command line, such as repeating one of the last several commands you've used or
copying the most recent history of command activity to the Clipboard.
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A right-click in the drawing area when no command is active displays a set of basic options
for editing your file, such as the command most recently used, Undo, Redo, Pan, and Zoom,
to name a few (see Figure 2.13). The Cut, Copy, and Paste commands can be found under the
Clipboard option.

FIGURE 2.13 Repeat HELP

A set of basic options Clipboard >

Isolate >

Undo Designfeedmanagedocswitch
Redo Ctrl+Y

Pan h

Zoom

(SF-C IR

SteeringWheels
Action Recorder >

Subobject Selection Filter 3
Quick Select...

QuickCalc

% Find...

[¥ Options...

£ B

If you're ever in doubt about what to do in AutoCAD, you can right-click to see a list of
options. You'll learn more about these options later in this book. For now, let’s move on to the
topic of selecting objects.

How WE’LL SHOW COMMAND OPTIONS

As mentioned earlier, the options in the command line are shown with a slightly darker back-
ground color so that you can easily determine the name of the options (see Figure 2.14).

FIGURE 2.14

The Angle and chord
Length options are
separated by a gray
background.

:nd point of arc (hold Ctrl to switch direction) or [Angle chord Length]:

Unfortunately, it’s a bit more difficult to show the options in the same way in this book. Thus, from
now on when we show the command options, we’ll use a forward slash mark to separate the options.
For example, in the Arc command options discussed earlier, you saw this command prompt:

Specify end point of arc or [Angle chord Length]
We'll show it like this, using the / symbol to separate the command options:

Specify end point of arc or [Angle/chord Length]
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Without the / symbol, you might confuse the option names as Angle chord and Length,
or you may even think that there are three options named Angle, chord, and Length. Those of
you familiar with older versions of AutoCAD will recognize this use of the / symbol as the way
AutoCAD used to separate command options in the command line.

Selecting Objects

In AutoCAD, you can select objects in many ways. The following sections cover two ways:
object-selection methods unique to AutoCAD and the Noun/Verb method, the more common
selection method used in most popular graphics programs. Because these two methods play a
major role in working with AutoCAD, it’s a good idea to familiarize yourself with them early on.

If you need to select objects by their characteristics rather than by their location, see Chapter 14,
“Advanced Editing and Organizing,” which describes the Quick Select and Object Selection
Filters tools. These tools let you easily select a set of objects based on their properties, including
object type, color, layer assignment, and so on.

Selecting Objects in AutoCAD

With many AutoCAD commands, you'll see the Select objects: prompt. Along with

this prompt, the cursor changes from crosshairs to the Object Selection cursor (look back at
Figure 2.5). Whenever you see the Select objects: prompt and the square Pickbox cursor, you
have several options while making your selection. Often, as you select objects on the screen,
you’ll change your mind about a selection or accidentally select an object that you don’t want.
Let’s look at most of the selection options available in AutoCAD and learn what to do when you
make the wrong selection.

Before you continue, you'll turn off two features that, although extremely useful, can be con-
fusing to new users. These features are called Running Osnaps and Osnap Tracking. You'll get
a chance to explore these features in depth later in this book, but for now follow these steps to
turn them off:

1. Check to see if either Object Snap or Object Snap Tracking is turned on in the status bar.
If they're turned on, they will be a light blue.

Object Snap Tracking

| Object Snap

R KA+ N8

2. To turn off Object Snap, click the tool in the status bar. When turned off, it will change
to gray.

Now, let’s see how to select an object in AutoCAD:
1. Choose Move from the Home tab’s Modify panel, or type M.

2. Atthe Select objects: prompt, click each of the two horizontal lines that constitute
the door. As you know, whenever AutoCAD wants you to select objects, the cursor turns
into the small square pickbox. This tells you that you're in Object Selection mode. As you
place the cursor over an object, it appears thicker to give you a better idea of what you're
about to select. As you click an object, it’s highlighted, as shown in Figure 2.15.
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FIGURE 2.15

Select the lines of the
door, and they become
highlighted.

SELECTING OBJECTS

|=1[Top)I2D Wireframe]
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If objects don’t become “thicker” as you roll over them with your selection cursor, the
Selection preview system variable may be turned off. You can turn it back on by entering
selectionpreview.] 3. This setting can also be found in the Selection tab of the Options
dialog box. See Appendix B for more on the Options dialog box, and see Bonus Chapter 4,
“System Variables and Dimension Styles,” for more on system variables, available at
www.omura.com/chapters.

. After making your selections, you may decide to deselect some items. Enter U from the

keyboard. Notice that one line is no longer highlighted. When you type U, objects are
deselected, one at a time, in reverse order of selection.

. You can deselect objects in another way. Hold down the Shift key and click the remain-

ing highlighted line. It reverts to a solid line, showing you that it’s no longer selected for
editing.

. By now, you've deselected both lines. Let’s try another method for selecting groups of

objects. To select objects with a window selection, type W.. The cursor changes to a Point
Selection cursor, and the prompt changes to

Specify first corner:

. Click a point below and to the left of the rectangle representing the door. As you move

your cursor across the screen, a selection window appears and stretches across the draw-
ing area. Also notice that the window has a blue tint.

. After the selection window completely encloses the door but not the ar, click this loca-

tion to highlight the entire door. This window selects only objects that are completely
enclosed by the window, as shown in Figure 2.16.

Don’t confuse the selection window you're creating here with the zoom window you
used in Chapter 1, which defines an area of the drawing you want to enlarge. Remember
that the Window option works differently under the Zoom command than it does for
other editing commands.
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FIGURE 2.16 First corner of window Opposite corner of window
Selecting the doorina
selection window

[=1Top]|2D Wireframe]

L

8. Press .. This tells AutoCAD that you've finished selecting objects. It’s important to
remember to press ! as soon as you finish selecting the objects you want to edit. A new
prompt, Specify base point or [Displacement] <Displacement>:, appears. The
cursor changes to its Point Selection mode.

Now you've seen how the selection process works in AutoCAD—Dbut you're in the middle of
the Move command. The next section discusses the prompt that’s on your screen and describes
how to enter base points and displacement distances.

CONTROLLING THE STATUS BAR DISPLAY

Toward the right side of the status bar, you'll see a tool icon with three horizontal lines. This tool
opens a menu that controls the display of the status bar. You use this menu to turn the items in the
status bar on or off. A check mark by an item indicates that it’s currently on. If for some reason you
don’t see all of the buttons mentioned in the following exercise, check this menu to make sure all
the status bar options are turned on. For the items in the left half of the status bar, choose Status
Toggles from the menu.

v Workspace Switching

v Annotation Monitor
Units
Quick Properties

Lock UI
8-+ % 0@
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Providing Base Points
When you move or copy objects, AutoCAD prompts you for a base point, which is a difficult
concept to grasp. AutoCAD must be told specifically from where and to where the move occurs.
The base point is the exact location from which you determine the distance and direction of the
move. After the base point is determined, you can tell AutoCAD where to move the object in
relation to that point.

Follow these steps to practice using base points:

1. To select a base point, press Shift+right-click. A menu appears, displaying the Object

FIGURE 2.17
The Object Snap

options

Snap options (see Figure 2.17).

Temporary track point
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Insert
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None
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Osnap Settings...

When you right-click, make sure that the cursor is within the AutoCAD drawing area;
otherwise, you won't get the results described in this book.

2. Choose Intersection from the Object Snap menu. The Object Snap menu closes.

. Move the cursor to the lower-right corner of the door. Notice that as you approach the

corner, a small x-shaped graphic appears on the corner. This is called an osnap marker.

. After the x-shaped marker appears, hold the mouse motionless for a second or two. A tool

tip appears, telling you the current osnap point that AutoCAD has selected.

. Click the left mouse button to select the intersection indicated by the osnap marker.

Whenever you see the osnap marker at the point you want to select, you don’t have to
point exactly at the location with your cursor. Just left-click to select the exact osnap point
(see Figure 2.18). In this case, you selected the exact intersection of two lines.
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FIGURE 2.18 Intersection marker
Using the Point
Selection cursor and
osnap marker

[=1[Top]I2D Wireframe]
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6. Atthe Specify second point or <use first point as displacement>: prompt,
hold down the Shift key and right-click again to open the Object Snap menu.

7. This time, you'll use the Endpoint osnap, but instead of clicking the option with the
mouse, type E.

8. Pick the lower-right end of the arc you drew earlier. (Remember that you need to move
your cursor close to the endpoint just until the osnap marker appears.) The door moves so
that the corner connects exactly with the endpoint of the arc (see Figure 2.19).

FIGURE 2.19 Endpoint marker
Moving the rectangle
to its new position [=ITopli2D Wieframe]
using the Endpoint

osnap \
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As you can see, the osnap options let you select specific points on an object. You used
Endpoint and Intersection in this exercise, but other options are available. Chapter 3 discusses
some of the other osnap options. You may have also noticed that the osnap marker is different
for each of the options you used. You'll learn more about osnaps in Chapter 3. Now let’s con-
tinue with our look at point selection.

You may have noticed the statement Use first point as displacement in the promptin
step 6 of the preceding exercise. This means that if you press ! instead of clicking a point, the
object will move a distance based on the coordinates of the point you selected as a base point.
If, for example, the point you click for the base point is at coordinate 2,4, the object will move 2
units in the x-axis and 4 units in the y-axis.

If you want to specify an exact distance and direction by typing a value, select any point
on the screen as a base point. As an alternative, you can type @ followed by . at the base point
prompt; then, enter the second point’s location in relative coordinates. Remember that @ means
the last point selected. In the next exercise, you'll try moving the entire door an exact distance of
1 unit at a 45° angle. Metric users will move the door 3 units at a 45° angle. Here are the steps:

1. Click the Move tool on the Home tab’s Modify panel.

2. Type P. The set of objects you selected in the previous exercise is highlighted. P is a
selection option that selects the previously selected set of objects.

3. You're still in Object Selection mode, so click the arc to include it in the set of selected
objects. The entire door, including the arc, is highlighted.

4. Press I to tell AutoCAD that you've finished your selection. The cursor changes to Point
Selection mode.

5. Atthe Specify base point or [Displacement] <Displacement>: prompt, choose a
point on the screen between the door and the left side of the screen (see Figure 2.20).

FIGURE 2.20 Base point
The highlighted door
and the base point just [=Top]i2D Wireframe]

to the left of the door.
Note that the base
point doesn’t need to
be on the object that
you're moving.
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6. Move the cursor around slowly and notice that the door moves as if the base point you
selected were attached to it. The door moves with the cursor, at a fixed distance from it.
This demonstrates how the base point relates to the objects you select.

7. Type @1<-45.. (Metric users should type @3<-45.1.) The door moves to a new location on
the screen at a distance of 1 unit (3 for metric users) from its previous location and at an
angle of minus 45°, which is a direction that is downward at a 45-degree angle.

If AutoCAD is waiting for a command, you can repeat the last command used by pressing the
spacebar or pressing .. You can also right-click in the drawing area and select the option at
the top of the list. If you right-click the Command window, a context menu offers an option for the
most recent commands.

This exercise illustrates that the base point doesn’t have to be on the object you're manipu-
lating; it can be virtually anywhere on your drawing. You also saw how to reselect a group of
objects that were selected previously without having to duplicate the selection process.

Using Noun/Verb Selection

Nearly all graphics programs today allow the Noun/Verb method for selecting objects. This
method requires you to select objects before you issue a command to edit them—that is, you
identify the “noun” (the object that you want to work on) before the “verb” (the action that you
want to perform on it). The following exercises show you how to use the Noun/Verb method in
AutoCAD.

You've seen that when AutoCAD is waiting for a command, it displays the crosshair cursor
with the small square. As mentioned, this square is a pickbox superimposed on the cursor. It
indicates that you can select objects even while the Command prompt appears at the bottom
of the screen and no command is currently active. The square momentarily disappears when
you're in a command that asks you to select points.

OTHER SELECTION OPTIONS

There are several other selection options that you haven'’t tried yet. You'll see how these options
work in exercises later in this book. Or, if youre adventurous, try them now on your own. To use
these options, type their keyboard abbreviations (shown in brackets in the following list) at any
Select objects: prompt:

Add [AJ] Switches from Remove mode to the Add mode. See the description for Remove
later in this sidebar.

All [ALL] Selects all of the objects in a drawing except those in frozen or locked layers.
(See Chapter 5, “Keeping Track of Layers and Blocks,” for information on layers.)

Box [B.]] Forces the standard selection window so that a left-to-right selection uses a
standard window and a right-to-left selection uses a crossing window.

Crossing [C] Similar to the Window selection option (described later in this sidebar) but
selects anything that is entirely within or crosses through the window that you define.
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Crossing Polygon [CP.]] Acts exactly like Window Polygon (described later in this sidebar),
but like the Crossing selection option, selects anything that crosses through a polygon boundary.

Fence [F.] Selects objects that are crossed by a temporary line called a fence. This operation is
like using a line to cross out the objects you want to select. After you invoke this option, you can
then pick points, as when you're drawing a series of line segments. After you finish drawing the
fence, press ./, and then go on to select other objects or press ! again to finish your selection.

Use a Fence selection
to extend a set of
lines to a spline.

Fence Result

Group [G] Allows you to select a group by name.
Last [LJ] Selects the last object you created.

Multiple [M.] Lets you select several objects first before AutoCAD highlights them. In
alarge file, selecting objects individually can cause AutoCAD to pause after each selection
while it locates and highlights each object. The Multiple option can speed things up: First
you select all of the objects quickly and then you highlight them all by pressing 1. This has
no menu equivalent.

Previous [P.]] Selects the last object or set of objects that was edited or changed.

Remove [R.]] Switches to a selection mode whereby the objects you click are removed
from the selection set.

Subobject [SU] Allows selection of faces, edges, and vertices of 3D solid objects. This can
also be accomplished by pressing the Ctrl key while picking.

Object [0]] Ends selecting by Subobject and restores normal behavior.
Undo [UJ] Removes the most recently added object from the selection set.

Window [W.] Forces a standard window selection. This option is useful when your
drawing area is too crowded to use the Autoselect feature to place a window around a set of
objects. (See the Auto entry later in this sidebar.) It prevents you from accidentally selecting
an object with a single pick when you're placing your window.

Window Polygon [WP.] Lets you select objects by enclosing them in an irregularly
shaped polygon boundary. When you use this option, you see the First polygon point:
prompt. You then pick points to define the polygon boundary. As you pick points, the
Specify endpoint of line or [Undo]: prompt appears. Select as many points as

continues
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continued

you need to define the boundary. You can undo boundary line segments as you go by press-
ing U.J. With the boundary defined, press J. The bounded objects are highlighted and the
Select objects: prompt returns, allowing you to use more selection options.

A window polygon selection

The following two selection options are also available but are seldom used. They’re intended for use
in creating custom menu options or custom tools:

Auto [AU.]] Forces the standard automatic window or crossing window when a point

is picked and no object is found. (See the section “Using Autoselect” later in this chapter.)
You produce a standard window when you pick the two window corners from left to right,
and you produce a crossing window when you pick the two corners from right to left. After
you select this option, it remains active for the duration of the current command. Auto is
intended for use on systems on which the Autoselect feature has been turned off.

Single [SI.]] Forces the current command to select only a single object. If you use this
option, you can pick a single object and the current command acts on that object as if you
had pressed J immediately after selecting it. This has no menu equivalent.

T
«* Move

In addition to Noun/Verb selection, AutoCAD offers selection options that let you use famil-
iar GUI techniques. See Appendix B to learn how you can control object-selection methods. This
appendix also describes how to change the size of the Standard cursor.

Try moving objects by first selecting them and then using the Move command:

1. Press the Esc key twice to make sure that AutoCAD isn't in the middle of a command,
which you might have accidentally issued. Then click the arc. The arc is highlighted,
and you may also see squares appear at various points on the arc. As stated earlier, these
squares are called grips. You'll get a chance to work with them later.

2. Choose Move from the Home tab’s Modify panel. The cursor changes to Point Selection
mode. Notice that the grips on the arc disappear but the arc is still selected.

3. Atthe Specify base point or [Displacement] <Displacement>: prompt, pick any
point on the screen. The following prompt appears:

Specify second point or:
<use first point as displacement>:

4. Type @1<0... Metric users should type @3<0.. The arc moves to a new location 1 unit
(3 units for metric users) to the right.
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If this exercise doesn’t work as described here, chances are that the Noun/Verb setting has
been turned off on your copy of AutoCAD. To turn on the Noun/Verb setting, choose Options
from the Application menu to open the Options dialog box and then click the Selection tab. In
the Selection Modes group, select the check box next to the Noun/Verb Selection option and
click OK.

In this exercise, you picked the arc before issuing the Move command. Then, when you
clicked the Move tool, you didn’t see the Select objects: prompt. Instead, AutoCAD assumed
that you wanted to move the arc that you selected and went directly to the Specify base point
or [Displacement] <Displacement>: prompt.

USING AUTOSELECT

Next, you'll move the rest of the door in the same direction by using the Autoselect feature:

1. Pick a point just above and to the left of the rectangle representing the door. Be sure not
to pick the door itself. A selection window appears that you can drag across the screen
as you move the cursor. If you move the cursor to the left of the last point selected, the
window outline appears dotted and there’s a green tint inside the window (see the first
image in Figure 2.21). If you move the cursor to the right of that point, the outline appears
solid and there’s a blue tint inside (see the second image in Figure 2.21).

FIGURE 2.21 Crossing window
The dotted window
(first image) indi-
cates a crossing
selection; the solid
window (second
image) indicates a
standard selection P! e

window.

Standard window

N

T i)




60 |CHAPTER2 CREATING YOUR FIRST DRAWING

2. Pick a point below and to the right of the door so that the door, but not the arc, is com-
pletely enclosed by the window, as shown in the bottom image in Figure 2.21. The door is
highlighted (and, again, you may see grips appear at the lines” endpoints and midpoints).

3. Click the Move tool again. Just as in the preceding exercise, the Specify base point or
+ . .
[Displacement] <Displacement>: prompt appears.

4. Pick any point on the screen; then enter @1<0.. Metric users should enter @3<0.!. The
door joins with the arc.

The two selection windows you've just seen—the blue solid one and the dotted green one—
represent a standard window and a crossing window. If you use a standard window, anything
completely within the window is selected. If you use a crossing window, anything that crosses
through the window is selected. These two types of windows start automatically when you click
any blank portion of the drawing area with a Standard cursor or a Point Selection cursor, hence
the name Autoselect.

Next, you'll select objects with an automatic crossing window:

1. Pick a point below and to the right of the door. As you move the cursor left, the crossing
(dotted) window appears.

2. Select the next point so that the window encloses the door and part of the arc (see
Figure 2.22). The entire door, including the arc, is highlighted.

FIGURE 2.22

The door enclosed
by a crossing
window

3. Click the Move tool.

4. Pick any point on the screen; then enter @1<180.. Metric users should type @3<180.). The
door moves back to its original location.

You'll find that, in most cases, the Autoselect standard and crossing windows are all that you
need when selecting objects. They really save you time, so you'll want to become familiar with
these features.
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EDITING WITH GRIPS

MODIFYING AN AUTOSELECT WINDOW

Two settings, known as system variables, enable you to use the Autoselect feature in a more flexible
way. These two settings, Pickdrag and Pickauto, control the behavior of the Autoselect window,
giving you more options to select objects in your drawing.

Pickdrag If you click to start a selection window and then decide that you want to use a
window polygon, crossing polygon, or fence, you can type W.! for a window polygon, C for a
crossing polygon, or B for a fence. If this does not work, make sure that the Pickdrag sys-
tem variable is set to 2 by typing PICKDRAG-2.!.

Pickauto In acrowded drawing, you may want to use a selection window, but objects close
to the cursor may be selected instead. If you set Pickauto to 2 by typing PICKAUTO.12./,
you can click and drag your mouse over an object in a crowded drawing without having the
single object selected. AutoCAD will start a selection window instead. You can still use a
single click to select a single object.

Before continuing, click the Save tool in the Quick Access toolbar to save the Door . dwg file.
You won't want to save the changes you make in the next section, so saving now stores the cur-
rent condition of the file on your hard disk for safekeeping.

RESTRICTIONS ON NOUN/VERB OBJECT SELECTION

For many of the modifying or construction-oriented commands, the Noun/Verb selection
method is inappropriate because, for those commands, you must select more than one set of
objects. You'll know whether a command accepts the Noun/Verb selection method right away:.
Commands that don’t accept the Noun/Verb selection method clear the selection and then ask
you to select an object or set of objects.

If you'd like to take a break, now is a good time to do so. If you want, exit AutoCAD, and return
to this point in the chapter later. When you return, start AutoCAD and open the Door . dwg file.

CLICK AND DRAG TO LASSO OBJECTS

If you need to use an irregular-shaped window to select objects, you can use a click-and-drag motion
to start a lasso selection. A lasso enables you to draw an irregular “freehand” selection window of
any shape. Just as with the rectangular selection window, the direction of the lasso determines
the method of selection. A clockwise lasso creates a standard window, and a counterclockwise lasso
creates a crossing window.

Editing with Grips
Earlier, when you selected the door, grips appeared at the endpoints, center points, and mid-

points of the lines and arcs. You can use grips to make direct changes to the shape of objects or
to move and copy them quickly.
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If you didn’t see grips on the door in the previous exercise, your version of AutoCAD may have
the Grips feature turned off. To turn them on, refer to the information on grips in Appendix B.

So far, you've seen how operations in AutoCAD have a discrete beginning and ending. For
example, to draw an arc, you first issue the Arc command and then go through a series of opera-
tions, including answering prompts and picking points. When you're finished, you have an arc
and AutoCAD is ready for the next command.

The Grips feature plays by a different set of rules. Grips offer a small yet powerful set of edit-
ing functions that don’t conform to the lockstep command/prompt/input routine that you've
seen so far. As you work through the following exercises, it’s helpful to think of grips as a subset
of the standard method of operation in AutoCAD.

To practice using the Grips feature, you'll make some temporary modifications to the door
drawing.

Stretching Lines by Using Grips
In this exercise, you'll stretch one corner of the door by grabbing the grip points of two lines:
1. Use the Zoom Realtime tool from the Zoom tool in the View tab’s Navigate 2D panel to

adjust your view so that the size of the door is similar to what is shown in Figure 2.23.
You can click and drag the mouse wheel to pan the view if needed.

FIGURE 2.23
Stretching lines by
using grips. The top
image shows the rect-
angle’s corner being
stretched upward. The
bottom image shows
the new location of the
corner at the top of
the arc.

2. Press the Esc key to make sure that you're not in the middle of a command. Click a point
below and to the left of the door to start a selection window.
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. Click above and to the right of the rectangular part of the door, placing the selection win-

dow around the door rectangle to select it.

Place the cursor on the lower-left corner grip of the rectangle, but don’t press the mouse but-
ton yet. Notice that the cursor jumps to the grip point and that the grip is highlighted. You
also see some dimensions related to the objects associated with the grip.

. Move the cursor to another grip point. Notice again how the cursor jumps to it. When

placed on a grip, the cursor moves to the exact center of the grip point. This means that, for
example, if the cursor is placed on an endpoint grip, it’s on the exact endpoint of the object.

. Move the cursor to the upper-left corner grip of the rectangle and click. The grip becomes

a solid color and is now a hot grip. The prompt displays the following message:

**STRETCH**
Specify stretch point or [Base point/Copy/Undo/eXit]:

This prompt tells you that Stretch mode is active. Notice the options in the prompt. As you
move the cursor, the corner follows, and the lines of the rectangle stretch (see Figure 2.23).

You can control the size and color of grips by using the Selection tab in the Options dia-
log box; see Appendix B for details.

Move the cursor upward toward the top end of the arc and click that point. The rectangle
deforms with the corner placed at your pick point (see Figure 2.23).

Here you saw that a command called Stretch is issued by clicking a grip point. As you'll see
in these next steps, a handful of other hot-grip commands are also available:

1. Notice that the grips are still active. Click the grip point that you moved before to make it

a hot grip again.

2. Right-click to open a context menu that contains a list of grip-edit options (see Figure 2.24).

FIGURE 2.24
Alist of grip-edit

options

Enter

Recent Input 4

[3y Stretch
Move
(¢) Rotate
Scale
Alh Mirror
Base Point
%3 Copy
Reference

<R Undo

Exit

Ctrl+Z

When you click the joining grip point of two contiguous line segments, AutoCAD selects
the overlapping grips of two lines. When you stretch the corner away from its original
location, the endpoints of both lines follow.
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. Choose Base Point from the list, and then click a point to the right of the hot grip. Now as

you move the cursor, the hot grip moves relative to the cursor.

. Right-click again, choose Copy from the context menu, and enter @1<-30... (Metric users

should enter @3<-30.1.) Instead of the hot grip moving and the lines changing, copies of
the two lines are made with their endpoints 1 unit (or 3 units for metric users) below and
to the right of the first set of endpoints.

Pick another point just below the last. More copies are made.

. Press . or enter X to exit Stretch mode. You can also right-click again and choose Exit

from the context menu.

In this exercise, you saw that you can select a base point other than the hot grip. You also saw
how you can specify relative coordinates to move or copy a hot grip. Finally, you saw that with
grips selected on an object, right-clicking opens a context menu that contains grip-edit options.

SELECTING MULTIPLE GRIPS

Suppose you want to stretch two grips together. You can select multiple grips by holding down the
Shift key while selecting grips. For example, if you want to stretch the top two corners of a rectangle,
select the rectangle, and then Shift-click the two top corner grips. Click one of the selected grips
and move it to a new location. All of the selected grips will move together.

Moving and Rotating with Grips

As you've just seen, the Grips feature is an alternative method for editing your drawings. You've
already seen how you can stretch endpoints, but you can do much more with grips. The next
exercise demonstrates some other options. You'll start by undoing the modifications you made
in the preceding exercise:

1.
2.

Type U-. The copies of the stretched lines disappear.
Press ! again. The deformed door snaps back to its original form.

Pressing ! at the Command prompt causes AutoCAD to repeat the last command
entered—in this case, U.

Type Zoom.10.6.] to show more of the drawing’s work area.

4. You are going to select the entire door. First, click a blank area below and to the right of

the door.

. Move the cursor to a location above and to the left of the rectangular portion of the door

and click. Because you went from right to left, you created a crossing window. Recall that
the crossing window selects anything enclosed and crossing through the window.

. Click the lower-left grip of the rectangle to turn it into a hot grip. Just as before, as you

move your cursor the corner stretches.

Right-click and choose Move from the context menu. The Command window displays
the following:

**MOVE**
Specify move point or [Base point/Copy/Undo/eXit]
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Now as you move the cursor, the entire door moves with it.

8. Position the door near the center of the screen and click. The door moves to the center of
the screen. Notice that the Command prompt returns but the door remains highlighted,
indicating that it’s still selected for the next operation.

9. Click the lower-left grip again, right-click, and choose Rotate from the context menu. The
Command window displays the following;:

**ROTATE**
Specify rotation angle or [Base point/Copy/Undo/Reference/eXit]:

As you move the cursor, the door rotates about the grip point.

10. Position the cursor so that the door rotates approximately 180° (see Figure 2.25). Then
Ctrl+click (hold down the Ctrl key and press the left mouse button). A copy of the door
appears in the new rotated position, leaving the original door in place.

FIGURE 2.25
Rotating and copying
the door by using a
hot grip. Notice that
more than one object
is affected by the grip
edit, even though only
one grip is hot. "\

[=][Top]I2D Wireframe]

IR

11. Press J to exit Grip Edit mode.

You've seen how the Move command is duplicated in a modified way as a hot-grip com-
mand. Other hot-grip commands (Stretch, Rotate, Scale, and Mirror) have similar counterparts
in the standard set of AutoCAD commands. You'll see how those work in Chapter 11, “Using
Dimensions,” and Chapter 13, “Copying Existing Drawings from Other Sources.”

After you complete any operation by using grips, the objects are still highlighted with their
grips active. To clear the grip selection, press the Esc key.

In this exercise, you saw how hot-grip options appear in a context menu. Several other
options are available in that menu, including Exit, Base Point, Copy, and Undo.

You can access many of these grip-edit options by pressing the spacebar or - while a grip is
selected. With each press, the next option becomes active. The options then repeat if you con-
tinue to press .. The Ctrl key acts as a shortcut to the Copy option. You have to use it only once;
then, each time you click a point, a copy is made.
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SCALING WITH GRIPS

Grips can be used to scale an object graphically to fit between two other objects. For example, a door
can be scaled to fit within a door frame. Place the door so that its hinge side is at the door frame
and the door is oriented properly for the frame. With the door selected, click the grip at the hinge
side. Right-click and select Scale. Type R or select Reference from the command line, and then
click the grip at the hinge again. Click the grip at the end of the arc representing the door swing.
Finally, click the opposite side of the door frame.

Click the grip Right-click and Type R and Click the endpoint of
at the hinge. select Scale. click these grips the frame to scale the door.
‘: % hinge side first.
: / ,‘ ; /
4.‘} .‘ - .\ b "" ,"/’

Understanding Dynamic Input

You've seen how AutoCAD displays a lot of information at the cursor through its Dynamic
Input display. In this section, you'll now get a chance to explore the Dynamic Input display
through grip editing.

You'll start by going back to the original version of the Door . dwg drawing that you saved earlier:

1. Click the Close icon in the Drawing tab of the drawing area.

2. When you're asked if you want to save changes, click No.

3. Click Open from the Quick Access toolbar, and then locate and select the Door . dwg file
that you saved earlier. You can also open the doorsample.dwg file from the sample files
that you installed from this book’s web page.

The door appears in the condition in which you left it when you last saved the file.

4. Click the Pan tool in the Navigation bar, and click and drag the mouse to pan the view to
the center of the drawing area.

5. Right-click and select Exit to exit the Pan tool.
6. Click the arc to expose its grips.

DON’T SEE THE DYNAMIC INPUT DISPLAY?

If you don’t see the Dynamic Input display at the cursor, type Dynmode ./ to turn it on. You can
also click the Customization tool at the far-right end of the status bar and select Dynamic Input to
add the Dynamic Input tool to the status bar. This tool lets you toggle the Dynamic Input display
on and off.
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7. Place the cursor on the grip at the middle of the arc, but don't click it. (This is called hover-
ing over a grip.) You see the dimensions of the arc appear as well as a menu offering two
options: Stretch and Radius. The dimensions are useful when you need to check the size
of objects you've drawn (see Figure 2.26).

FIGURE 2.26
Hovering over a grip

Stretch
3.0000 [ Radius
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8. Click the Radius option in the grip menu. The Command prompt appears at the cursor,
and the radius dimension changes to a text box.

9. Move the cursor toward the upper-right corner of the drawing area. The radius dimen-
sion of the arc changes as you move the cursor.

10. Enter 4. Metric users enter 12.1. As you type, the new value appears in the radius
dimension. When you press ., the arc changes to the new radius.

11. Click the Undo button to revert to the original arc size.

Here you saw the basic methods for using the Dynamic Input display. You can hover over
an object’s grip to display its dimensions along with a grip menu. The menu appears for many
but not all grips, and the contents of the menu depend on the object selected. Click the grip, and
if available, the dimensions can be edited directly through the keyboard. In this example, you
were able to change the radius of the arc to an exact value by selecting the Radius option from
the grip menu and then entering a value. Depending on the grip you click, you can change a
dimension through direct keyboard input. For example, if you want to change the degrees the
arc covers instead of its radius, you can hover over the arrow grip at either end of the arc and
select Lengthen. The dimensions that appear can then be edited to increase or decrease the
length of the arc without affecting its radius.
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Next, try Dynamic Input display on a line:

1. Click the bottommost line of the door, as shown in Figure 2.27. Hover over the rightmost
grip on the selected line. Just as you saw with the arc, you can see the dimensions of the
line, including its length and directional angle. You also see a menu that offers the Stretch
and Lengthen options.

FIGURE 2.27
Selecting a line on the
door

o —

0° Stretch
Lengthen

2. Click the grip over which you're hovering, and then move the cursor up and to the
right. You see two dimensions: One indicates the overall length, and the other shows the
change in length of the line. You also see the Command prompt at the cursor. Notice that
the dimension indicating the change in length is highlighted (see Figure 2.28).

FIGURE 2.28

The overall length
dimension and the
change in length
dimension
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3. Type1and press the Tab key, not the Enter key, to increase the length of the line by 1 unit.
Metric users should enter 3 and press the Tab key. Now, as you move the cursor, the line
is locked at a new length that is 1 (or 3) units longer than its original length. Also notice
that the overall dimension is highlighted. You also see a lock icon on the length dimen-
sion (see Figure 2.29).

FIGURE 2.29
The line locked at a new
length

0000l

4. Press the Tab key again. The angle value is highlighted.
5. Type 45 and press the Tab key to lock the angle of the line at 45°.

6. Make sure that the cursor isn't too close to the locked endpoint of the line and then click
the left mouse button. The line is now in its new orientation with a length of 4 (12 for met-
ric users) and an angle of 45° as shown in Figure 2.30.

FIGURE 2.30
The line’s new length
and orientation
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You can see that the Dynamic Input display lets you enter specific dimensions for the
selected object, making possible precise changes in an object’s size. Choose Lengthen from the
grip menu if you just want to change the length of the line.

You can also use the Dynamic Input display while using other grip-editing features. Try the
following exercise to see how the Dynamic Input display works while moving objects:

1.

Click above and to the right of the door drawing to start a crossing selection window.

. Click below and to the left to select the entire door drawing.

2
3.
4

Click the middle grip of the arc.

. Right-click and choose Move. You see the Command prompt at the cursor with the

distance value highlighted. As you move the cursor, you can see the distance and angle
values in the Dynamic Input display change (see Figure 2.31).

FIGURE 2.31
The Dynamic Input B m
display
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5. Type 4 (metric users enter 12) and then press the Tab key. As you move the cursor, the

distance from the original location of the arc’s midpoint is locked at 4 (or 12) units. The
angle value is now highlighted and available for editing.

. Type 225 and then press the Tab key to lock the angle at 225°.

Click a location away from the door drawing. The door moves to its new location, exactly
4 units (12 units for metric users) from its original location.

As you can see from these exercises, the Dynamic Input display adds some helpful methods
for editing objects. To summarize, here is a rundown of the basic Dynamic Input display features:

*
*

You can quickly check the dimensions of an object by selecting it and then hovering over a grip.

You can alter an object’s dimensions by entering values into the highlighted dimensions of
the Dynamic Input display.
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¢ Tohighlight a different dimension, press the Tab key.

¢ To accept any changes you've made using the Dynamic Input display, click at a location
away from the grip you're editing. You can also press . or the spacebar.

Not all grips offer dimensions that can be edited. If you click the midpoint grip on the line,
for example, you won't see the dimensions of the line, although you’ll see the Command prompt
and you’ll be able to enter a new coordinate for the midpoint.

As you've seen in the arc and line examples, each object offers a different set of dimensions.
If you like the way that the Dynamic Input display works, you can experiment on other types of
objects. AutoCAD offers a number of settings that let you control the behavior of the Dynamic
Input display. You'll learn about those settings in Appendix B.

TYPING COORDINATES WITH DYNAMIC INPUT

When entering coordinates through the keyboard while Dynamic Input is enabled, you have to
use a slightly different notation for relative and absolute coordinates. If you're entering relative
coordinates for a series of points as in drawing a polygon with the Line command, you can leave off
the @ sign after the first point is selected, so instead of typing @12,9.], you can simply type 12,9.1.
If you are entering absolute coordinates, you need to precede your coordinate list with a # sign.
So instead of entering 1,1.] to specify a point at coordinate 1,1, you would need to enter #1,1.].

Displaying Data in a Text Window

You may have noticed that as you work in AutoCAD, the activity displayed in the Command
window scrolls up. Sometimes, it’s helpful to view information that has scrolled past the view
shown in the Command window. For example, you can review the command activity from your
session to check input values or to recall other data-entry information. Try the following exer-
cise to see how the text window works:

1. From the Home tab’s expanded Properties panel, click the List tool.

Bylayer ~ -
yLay! G

Bylayer ~

2. Atthe Select objects: prompt, click the arc and press . A text window appears
and displays information about the arc (see Figure 2.32). If your command window is
undocked, it will expand to display the information. Toward the bottom is the list of the
arc’s properties. Don’t worry if the meaning of some listed properties isn't obvious yet; as
you work your way through this book, you'll learn what the properties of an object mean.
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FIGURE 2.32

The expanded
AutoCAD Command
window showing the
data displayed by the
List tool
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3. If your command window is unlocked, you can dismiss the expanded Command win-
dow by clicking in the drawing area. To bring it back, press the F2 function key or click
the up-pointing arrowhead at the far right of the unlocked Command window.

You can set the number of lines that AutoCAD retains by using the Options dialog box, or
you can have AutoCAD record the AutoCAD Text Window information in a text file.

When you have more than one document open, the AutoCAD Command window displays a
listing for the drawing that is currently active.

DOCKING THE COMMAND WINDOW

If you've used AutoCAD before, you may wonder if you can restore the old-style Command window.
You can do this by docking the window to the bottom of the AutoCAD window. Once this is done,
the Command window behaves the same way as in earlier versions of AutoCAD. You can open a
separate Text Window by entering TEXTSCR.! or by pressing F2.

Displaying the Properties of an Object
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While we're on the subject of displaying information, you'll want to know about the Properties
palette. In the preceding exercise, you saw how the List command showed some information

regarding the properties of an object, such as the location of an arc’s center and endpoints. You
can also double-click an object to display the Quick Properties palette that shows other basic
information about the object. (You might accidentally display the Quick Properties palette from
time to time!) The Properties palette provides a more complete view of an object’s properties
with the additional feature of allowing you to make changes to those properties. The Properties
palette is so useful that you may want to consider leaving it open all the time.

To see what the Properties palette is for, try the following exercise:

1. If you haven't done so already, select the arc in the drawing, right-click it, and select
Properties to open the Properties palette, which displays a list of the arc’s properties.
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FIGURE 2.33
Object Properties

palette
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Don’t worry if many of the items in this palette are undecipherable; you'll learn more
about this palette as you work through the early chapters of this book. For now, just be
aware that you can get to this palette with a right-click and that it displays the object’s
properties. You can also use it to modify many of the properties listed (see Figure 2.33).
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3D Visualization
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. Click the small Auto-hide box at the top of the Properties palette. It’s the icon that looks

like a double arrow. The icon changes to a single arrow. The Auto-hide option in the
Properties palette lets you keep the palette open without having it take up too much
of the drawing area. This can be useful when you need to edit the properties of many
objects.

- W

ByLayer
0

. Move the cursor away from the Properties palette. The Properties palette collapses so that

only the title bar remains.

Hover the cursor on the Properties palette title bar. The Properties palette opens to dis-
play all of the options again.

. Click the Auto-hide box again to restore the “always open” mode of the palette.

. Close the Properties palette by clicking the X in its upper corner. (The X appears in

the upper-left or upper-right corner, depending on the placement of the palette in the
AutoCAD window.) You can also right-click the title bar on the side of the Properties pal-
ette and then choose Close from the context menu.

You're finished with the door drawing, so choose Close from the Application menu.
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8. In the AutoCAD dialog box, click the No button. (You've already saved this file just as
you want it, so you don’t need to save it again.)

USING ROTATE REFERENCE TO ALIGN OBJECTS

You can use the Rotate command’s Reference option to align a set of objects graphically to another
object. For example, suppose you want to rotate a set of circles inside a hexagon to align with the
corner of the hexagon.

To do this, you can use the Reference option as follows:
1. Startthe Rotate command, and select the circles.

2. AttheSpecify base point: prompt, use the Center osnap to select the center of the hexagon
as represented by the central circle. Once you do this, the objects rotate around the selected point
as you move your cursor.

Select the Type R and Select the center Select a corner
center of the select the center of one of the circles of the hexagon
hexagon for of the hexagon you want to align to align the circles
the base point. again. to a corner. to the corners.

3. AttheSpecify rotation angle or [Copy/Reference]: prompt, enter Rl

4. AttheSpecify the reference angle <0>: prompt, use the Center osnap to select the center
of the hexagon again. You can also enter @ since the last point you selected was the center.

5. AttheSpecify second point: prompt, use the Center osnap to select the center of one of the
circles you want to align with the hexagon. Now, as you move the cursor, the circle whose center
you selected is aligned with the cursor angle.

6. AttheSpecify the new angle or [Points]: prompt, use the Endpoint osnap to select one
of the corners of the hexagon. The circles align with the corners.

You can also use grips to align objects. Here’s how: Select the object or set of objects and then click
a grip. The grip you select becomes the rotation point, so select this first grip carefully. Right-click
and select Rotate. Type R and select the grip you just selected and another point to determine
the reference angle. Finally, select the new angle for the object or set of objects. If you want to
rotate around a point other than the first grip, use the Grip Base right-click option. If you'd like to
experiment with the Rotate Reference option, we've provided a sample file that you can use called
rotatereference.dwg.




